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Overview

A summary of the installation process

Introduction

It is assumed that all hardware is installed and connected before you
start the installation procedure. It is also assumed that the grid
topology has been designed and specified in conjunction with a
NetApp Solutions Engineer to meet deployment requirements.

Intended Audience

This guide is intended for technical personnel trained to install and
support the StorageGRID system. An advanced level of computer
literacy is required, including knowledge of Linux/Unix command
shells, networking, and server hardware setup and configuration.

This guide assumes that you are familiar with the StorageGRID
system's general design, configurations and options. It also assumes
that you received training in grid provisioning, installation, and
integration.

NetApp StorageGRID
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Installation Overview and Checklists

Prepare for installation

‘ Gather required materials ‘

Prepare grid specification file
for deployment

‘ Prepare for TSM integration

Prepare virtual
machines

Start grid software

Install VMware vSphere on
virtual machine servers

|

Prepare a virtual machine for
the primary Admin Node

v

Prepare remaining virtual
machines for all other
grid nodes

with GDU
Start grid software on primary
Verif t Ki Admin Node
erily networking (Enable Services task)
v v
Start grid software on
Install grid software one Control Node

with GDU R

Load NMS

‘ Install primary Admin Node

v

Install Control Node ‘

v

‘ Install remaining grid nodes

v

Install drivers ‘

configuration settings
(Load Configuration task)

v

Start grid software on
remaining servers

v

Complete configuration
and back up data

Back up provisioning data
(primary Admin Node on VM)

Create file shares, customize
ILM, create FSG backup, etc.

Figure 1: Software Installation Overview

The following checklists provide an overview of the software installa-
tion process. Follow and complete the following checklists to install
StorageGRID:

1.

Prepare for installation. See “Prepare for Installation Checklist” on

page 10.

Complete the “Prepare Virtual Machines Checklist” on page 11.

Install, start, and configure grid software. See “Install and Config-
ure Grid Software Checklist” on page 12.

Prepare for Installation Checklist

Complete the following checklist to prepare for the installation of the

StorageGRID system.

Table 1: Prepare for Installation Checklist

v/ | Step | Task

See

Prepare for Software Installation

1. Read the Installation Guide and become familiar with all of the steps and
requirements needed to successfully install a grid.

10
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Table 1: Prepare for Installation Checklist (cont.)

v/ | Step | Task See
2, Gather all materials required to perform the installation. page 15
3. If the deployment includes an Archive Node that uses Tivoli® Storage page 18

Manager (TSM) middleware to write to archival media, read about TSM
configuration, and perform any necessary steps.

4. Prepare the grid specification file for deployment. page 22

The grid specification file is an XML file that encapsulates the grid
design. It specifies grid topology, grid configuration, and network infor-
mation. The grid specification file specifies site-specific information such
as network IP addresses.

Prepare Virtual Machines Checklist

Complete the following checklist to prepare virtual machines for the
installation of the StorageGRID system.

Table 2: Prepare Virtual Machine Checklist

v’ | Step | Task See

Prepare virtual machine servers

1. Set up virtual machine servers: page 23
e Install VMware ESX/ESXi.
* (Create and start virtual machines.

* Configure automatic restart for virtual machines.

Prepare a virtual machine for the primary Admin Node

2, Create the Provisioning media (floppy image) for installation of the page 29
primary Admin Node on a virtual machine.

The Provisioning media contains the deployment grid specification file
and an activation file required for the installation of Linux on the primary

Admin Node.

3. Install Linux on the virtual machine that will host the primary page 30
Admin Node.

4. Install VM tools and configure settings on the virtual machine that will page 33

host the primary Admin Node.

5. Load installation ISOs onto the primary Admin Node using the page 34
load_cds.py script. The Grid Deployment Utility (GDU) uses these ISO
images to install the grid software.

6. Install provisioning software on the primary Admin Node. page 37

NetApp StorageGRID 11
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Table 2: Prepare Virtual Machine Checklist (cont.)

v/ | Step | Task See
7. Provision the grid and create the Server Activation floppy image. page 38
Prepare virtual machines for all other grid nodes
8. Install Linux on the virtual machines that will host the remaining grid page 43
nodes. You can perform this operation in parallel on multiple servers.
9. Install VM tools and configure settings on virtual machines that will host | page 46
grid nodes.
10. Configure Storage Nodes for NFS storage. page 47

Install and Configure Grid Software Checklist

Complete the following checklist to install StorageGRID software on

prepared virtual machines.

Table 3: Install Grid Software Checklist

v | Step | Task See
Install grid software
1. Verify networking to confirm that the primary Admin Node can com-
municate with the other virtual machines or servers in the grid.
2. Use GDU to install grid software on the virtual machine that will hosts | page 51
the primary Admin Node.
Do not start grid software yet.
3. Use GDU to install grid software on the virtual machine that will hosts | page 51
the Control Node.
Do not start grid software yet.
4. Use GDU to install grid software on the virtual machines that will host | page 51
the remaining grid nodes. You can install grid software in parallel on
the remaining virtual machines.
Start grid software
5. Use GDU to start grid software on the primary Admin Node. page 54
6. Use GDU to start grid software on one Control Node. page 54
7. Use GDU to load NMS configuration settings on the primary page 55
Admin Node. Then log in to the NMS management interface (MI) to
start monitoring the grid.
8. Use GDU to start grid software on the other virtual machines. page 57
12 NetApp StorageGRID

215-06991_CO




Overview

Table 3: Install Grid Software Checklist (cont.)

v/ | Step | Task See
Complete integration and configuration

9. Back up the provisioning data to two safe, secure locations. Appendix A
WARNING This step is vital. Do not skip this step.

10. Configure the grid. page 61

1. Configure file shares. You must create file system shares for the clients | Administra-
that will access the grid. Both CIFS (Windows Workgroup or Active tor Guide
Directory) and NFES are supported.

12. Customize Gateway Node behavior. Consult the deployment’s config- | Administra-
uration information to determine if you need to customize the tor Guide
behavior of a Gateway Node, for example configure content protection
or cache parameters. Customization is achieved by configuring File
System Gateway (FSG) settings for replication groups. You may also
have to create and edit FSG profiles.

13. Verify client and grid integration. page 75

About Licensing Agreements

To complete aStorageGRID software installation, you must accept a
license agreement. After installation is complete, the text of the license
agreement is available on each server at /var/locall.license-accepted.txt.

About VMware vSphere

For the current supported versions of VMware software, see the

Interoperability Matrix Tool (IMT).

Configuring Virtual Disks

StorageGRID software installation is optimized to align partitions to
4K boundaries. No special action is required when creating virtual
disks in VMware for use with StorageGRID software. If using Fiber
Channel for your VMware datastores, select "LUN type" for all

attached drives.

NetApp StorageGRID
215-06991_CO0
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2

Prepare for Installation

Gather materials, prepare the grid specification file for
deployment, and prepare for TSM integration

Gather Materials

Gather the materials listed in Table 4 to prepare for the installation.

Table 4: Materials Checklist

v

Item

Notes

Default grid specification file

Use Grid Designer to deploy the default grid specification
file, and update it with data specific to the grid. For more
information on deployment, see the Grid Designer User
Guide.

provisioning-autoinst-<dn>.xml
file

Used during Linux installation to customize the primary
Admin Node for its role in the grid.

<dn> is the device name of the system drive of the server.

Located in the provisioning directory of the StorageGRID
Software CD or the StorageGRID Software Service Pack CD.
If a service pack is available, use the copy on the service
pack CD.

SUSE Linux Enterprise Server
(SLES) DVD

Use only the supported version of SLES for the Storage-
GRID 9.0 system. For supported versions, see the
Interoperability Matrix Tool (IMT).

NOTE Use of any version of SLES other than the correct
version will result in an installation failure.

Since you can load Linux on multiple servers in parallel, it
is helpful to have more than one copy of SLES DVD.

NetApp StorageGRID
215-06991_CO0
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Table 4: Materials Checklist (cont.)

v

Item

Notes

StorageGRID Software CD

Version 9.0.0

Confirm that the version matches the grid activation
information.

Used to install the base version of the grid software on all
grid servers. Works in conjunction with the Server Activa-
tion USB media that customizes each server to prepare it for
its assigned role in the grid.

Enablement Layer for Storage-
GRID Software CD

Version 9.0.0

Used to customize the Linux operating system installed on
each grid server. Only the packages needed to support the
services hosted on the server are retained to minimize the
overall footprint occupied by the operating system and
maximize the security of each server.

If available, Service Pack CDs

The StorageGRID Service Pack consists of two CDs:
¢ StorageGRID Software Service Pack CD version 9.0.x

*  Enablement Layer for StorageGRID Software Service
Pack CD version 9.0.x

where x is the service pack number. The service pack
number is identical for both CDs.

A service pack is the collection of fixes and enhancements
since the release of 9.0. Service packs are cumulative. For
example, Service Pack 9.0.2 includes the contents of Service
Pack 9.0.1.

Custom files

If applicable, custom files noted in the <custom-files>
sections of the grid specification file.

If the deployment includes an
Archive Node that uses Tivoli®
Storage Manager (TSM) mid-
dleware to write to archival
media, the CD containing the
required TSM Client packages.

The following Tivoli Storage Manager (TSM) Client
packages are required:

*  Backup Archive RPM (TIVsm-BA.i386.rpm)

¢ Tivoli API RPM (TIVsm-APLi386.rpm)

*  API 64-bit RPM (TIVsm-API164.i386.rpm) — for 64-bit
Archive Nodes only

For more information, see “TSM Client Packages” on
page 21.

Information on the supported version of the TSM packages
is available in the Interoperability Matrix Tool (IMT).

VMware® software and
documentation

For the current supported versions of VMware software,
see the Interoperability Matrix Tool (IMT).

16
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Table 4: Materials Checklist (cont.)

v | Item

Notes

Service laptop

Laptop must have:

Microsoft® Windows® operating system
Network port

Supported browser for StorageGRID 9.0
Telnet/ssh client (PuTTY version 0.57 or higher)

Winlmage, used to create the floppy disk images
required to install grid nodes in a virtual machine.
Winlmage is available at http://www.winimage.com)

Grid Designer

NOTE Each version of Grid Designer supports a
specific version of StorageGRID software.
Ensure you have the correct version of Grid
Designer.

WinSCP: if installing a primary Admin Node on a
virtual machine, use a tool such as WinSCP to transfer
files to and from the Admin Node. WinSCP can be

downloaded from:

http://winscp.net/eng/download.php

StorageGRID documentation

Administrator Guide
Grid Designer User Guide

Release Notes

Prepare Grid Specification File for Deployment

NetApp StorageGRID
215-06991_CO0

Prepare the grid specification file for deployment. That is, use Grid
Designer to customize the grid specification file by entering network-
ing and other information specific to the installation.

Prerequisites

The following materials and information are available:

e Grid specification file

e provisioning-autoinst-<dn>.xml file

17
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* Deployment-specific data such as networking IP addresses, NTP
server IP addresses, and server names

¢ Grid Designer software

¢ Service laptop

Procedure

1. Update the grid documentation.

Before deploying the grid, note all deployment-specific data such
as networking IP addresses, NTP server IP addresses, and server
names. This information is used for many integration, mainte-
nance, and expansion procedures.

2. Use Grid Designer to update the grid specification file with site-
specific information. For more information, see the Grid Designer
User Guide.

Grid Designer outputs OVF files used to automate the creation of
virtual machines using VMware vCenter Server.

Prepare for TSM Integration

18

Tivoli Storage Manager (TSM) writes to archival media. You can inte-
grate Archive Nodes that use TSM with either a new or an existing
TSM server.

For background information on the Archive Node, see the “Archive
Storage” chapter in the Administrator Guide.

NOTE You cannot co-host an Archive Node with a TSM server.

This section includes best practices for integrating the Archive Node
with a TSM server before beginning the integration. This section docu-
ments details of Archive Node operation that impact the configuration
of the TSM Server. It also provides required and recommended TSM
Server settings.

Subsequent sections of this guide (“Configure the TSM Server” on
page 63) include detailed sample instructions for preparing a TSM
Server that follow these recommendations.

NetApp StorageGRID
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Best Practices for TSM Integration
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Overview of Archive Node Configuration and
Operation

After an object is ingested into the grid (via a Gateway Node, the Stor-
ageGRID API (SGAPI), or CDMI), copies are made in the required
locations, including Archive Nodes, based on the grid’s ILM rules. The
grid manages the Archive Node as a location where objects are stored
indefinitely and are always accessible.

The TSM Archive Node acts as a client to a TSM server, and the TSM
client libraries are installed on the Archive Node by the StorageGRID
software installation process. Objects directed to the Archive Node for
storage are saved directly to the TSM as they are received. The
Archive Node does not stage objects before saving them to the TSM,
nor does it perform object aggregation. However, the Archive Node
may submit multiple objects to the TSM in a single transaction when
data rates warrant.

After the Archive Node saves an object to the TSM, the object is
managed by the TSM using its lifecycle/retention policies. These reten-
tion policies must be defined to be compatible with the operation of
the Archive Node. (That is, the objects saved by the Archive Node
must be stored indefinitely and must always be accessible by the
Archive Node, unless they are purged by the Archive Node.)

There is no connection between the grid’s ILM rules and the TSM
server’s lifecycle/retention policies. Each operate independently of one
another. However, as each object is ingested into the grid, you can
assign it a TSM management class. This management class is passed to
the TSM along with the object. Assigning different management
classes to different types of objects permits you to configure the TSM
to place objects in different storage pools, or to apply different migra-
tion or retention policies as required. For example, objects identified as
database backups (temporary content than can be overwritten with
newer data) could be treated differently than application data (fixed
content that must be retained indefinitely).

The Archive Node can be integrated with a new or an existing TSM
server.

The Archive Node does not require a dedicated TSM server. TSM
servers may be shared with other clients, provided that the TSM server
is sized appropriately for the maximum expected load.

19
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It is possible to configure more than one Archive Node to write to the
same TSM server; however, this configuration is only recommended if
the Archive Nodes write different sets of data to the TSM. Configuring
more than one Archive Node to write to the same TSM is not recom-
mended when each Archive Node writes copies of the same objects to
the archive. In the latter scenario, both copies are subject to a single
point of failure (the TSM server) for what are supposed to be indepen-
dent, redundant copies of data.

Archive Nodes do not make use of the Hierarchical Storage Manage-
ment (HSM) component of TSM.

TSM Configuration: Best Practices

When sizing and configuring the TSM server, you should be aware of
the following:

¢ Because the Archive Node does not aggregate objects before
saving them to the TSM, the TSM database must be sized to hold
references to all objects that will be written to the Archive Node.

e Archive Node software cannot tolerate the latency involved in
writing objects directly to tape or other removable media. There-
fore, the TSM server must be configured with a disk storage pool
for the initial storage of data saved by the Archive Node whenever
removable media are used.

*  You must configure TSM retention policies to use event-based
retention. The Archive Node does not support creation-based TSM
retention policies. We recommend setting retmin=0 and retver=0 in
the retention policy (which indicates that retention begins when
the Archive Node triggers a retention event, and is retained for 0
days after that). However, these values of retmin and retver are
optional.

The disk pool must be configured to migrate data to the tape pool (that
is, the tape pool must be the NXTSTGPOOL of the disk pool). The tape
pool must not be configured as a copy pool of the disk pool with simul-
taneous write to both pools (that is, the tape pool cannot be a
COPYSTGPOOL for the disk pool). To create offline copies of the tapes
containing Archive Node data, configure the TSM with a second tape
pool that is a copy pool of the tape pool used for Archive Node data.

Settings for the Archive Node are made in the NMS M, as directed
during the installation (as described on “Configure the TSM
Archive Node” on page 69).

NetApp StorageGRID
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TSM Client Packages

When installing software on the Archive Node server, you are
required to insert the TSM Client packages CD.

Download the TSM client packages from IBM. These packages are
included in a .tar file available at:

ftp://service.software.ibm.com/storage/tivoli-storage-management/
maintenance/client/

Information on the supported version of the TSM packages is available
in the Interoperability Matrix Tool (IMT).

Create CD

1. Download the LinuxX86 version of the .tar file corresponding to
the version of the TSM Library in use at the deployment. The .tar
file is found at <version> » Linux » LinuxX86 » <version>.

Unpack the .tar file.
3. Copy the .rpm files to a CD using standard CD burning software.
This CD is specific to a particular release of TSM Library Software. For

information on the correct version to use, see the site’s configuration
information.

Reference Materials for TSM Servers

NetApp StorageGRID
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You may find the following reference materials useful in helping you
prepare your TSM for integration with the Archive Node in aStorage-
GRID system:

e IBM Tape Device Drivers Installation and User’s Guide
http://www-01.ibm.com/support/
docview.wss?rs=577&uid=ssg157002972

e IBM Tape Device Drivers Programming Reference

http://www-01.ibm.com/support/
docview.wss?rs=577&uid=ssg157003032

e Administrator’s Reference for Tivoli Storage Manager for Linux Server:
Storage Manager for Linux Server » Administrator’'s Reference »
Chapter 2: Administrative Commands

http://publib.boulder.ibm.com/infocenter/tivihelp/v1rl/index.jsp
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Next Steps

Your next step is to prepare virtual machines. See Chapter 3: “Prepare
Virtual Machines”.
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3
Prepare Virtual Machines

How to prepare virtual machines for the installation of
StorageGRID software

Introduction

To prepare virtual machines for the installation of StorageGRID soft-
ware, perform the following:

1. “Install VMware vSphere on VM Servers” on page 23

2. “Prepare a Virtual Machine for the Primary Admin Node” on
page 29
3. “Prepare Virtual Machines for all Other Grid Nodes” on page 43

Install VMware vSphere on VM Servers

Install and configure VMware vSphere software on all servers that will
host virtual machines. These virtual machines will host grid nodes.
Perform the steps outlined in Table 5.

Table 5: Install and Configure VMware Software

v | Step | Action See
1. Install VMware vSphere software. page 24
2 Create the virtual machines. page 25
3. Configure ESX/ESXi for automatic restart. page 26
4 Start the virtual machines. page 28

NOTE For supported versions of VMware software, see the Interoperability
Matrix Tool (IMT).

NetApp StorageGRID 23
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Install VMware vSphere Software

24

To install and configure a virtual machine, install and configure
VMware vSphere software. In particular, you require VMware ESX/
ESXiand VMware vCenter Server software. For the steps required to
install these vSphere products see VMware documentation available
at: http://www.vmware.com/support/pubs

VMware vCenter Server

Create and configure virtual machines using the Open Virtualization
Format (OVF) files produced by Grid Designer:

e one OVF file per VM host — When deployed using vCenter Server,
this OVF file creates and configures all virtual machines hosted on
a physical server.

To use these OVF files, each destination host must have a single
datastore with enough free space to hold all virtual disks required
on this VM host. For information on the size of the virtual disks
required on a VM host, see the VM BOM created by Grid Designer.

After the initial deployment, you can use vCenter to migrate
virtual disks to multiple datastores.

* one OVF file per virtual machine — These OVF files create and
configure a single virtual machine. For information on the size of
the virtual disks required for each virtual machine, consult the VM
BOM created by Grid Designer.

VMware ESX/ESXi

You must install VMware ESX/ESXi on a prepared physical server with
correctly configured hardware. Grid hardware must be correctly con-
figured (including firmware versions and BIOS settings) before you
install VMware software.

Configure networking in the hypervisor as required to support net-
working for the grid. Note that an HAGC hosted on a virtual machine
does not require the use of a crossover cable for heartbeat.

Ensure that the datastore is large enough for the virtual machines and
virtual disks that are required to host the grid nodes. If you create
more than one datastore, name each datastore so that you can easily
identify which datastore to use for each grid node when you create
virtual machines.

NetApp StorageGRID
215-06991_CO0


http://www.vmware.com/support/pubs

Prepare Virtual Machines

VMware vSphere Client

Install the VMware vSphere client on your service laptop. The
VMware vSphere client allows you to connect to vCenter Server,
monitor ESX/ESXi servers, and create and configure virtual machines.

Create the Virtual Machines

NetApp StorageGRID
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After you install VMware ESX/ESXi, create one virtual machine for
each grid node installed on the server.

NOTE For more information on creating virtual machines, see VMware
vSphere documentation.

Create Virtual Machines Using OVF Files

Use this procedure when you are using VMware vCenter Server.

Prerequisites
e OVFfiles

* VM Bill of Materials (the GID<grid_ID>_REV<revision_number>
_GSPEC_VMBOM.html file) includes information on the virtual
machines to be installed on each physical server, including the type
of grid node hosted in each one and the resources that each VM
requires.

e vSphere client software
* when deploying one OVF file per VM Host:
» vCenter Server software

* adatastore large enough for all virtual disks for all virtual
machines hosted on the server

* when deploying one OVF file per virtual machine

* adatastore large enough for the virtual machine’s virtual disks

Procedure

¢ Connect to vCenter Server using vSphere Client software, and
deploy each OVF file to a host system.

This creates all of the required virtual machines, as described in the
VM bill of materials.
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Create Virtual Machines Manually

If required, use the NetApp StorageGRID Deployment Guide and the
information in the VM BOM generated by Grid Designer to manually
create virtual machines.

After you create all virtual machines hosted on the server, and you
adjust the resource allocations if required, configure the VMs to auto-
matucally restart when the ESX/ESXi server restarts. See “Configure
ESX/ESXi for Automatic Restart” below.

Configure ESX/ESXi for Automatic Restart

Configure the ESX/ESXi server to automatically restart the virtual
machines when the server restarts. Without an automatic restart, the
virtual machines and grid nodes remain shut down after VMware
ESX/ESXi server restarts.

Prerequisites

e All virtual machines have been created and configured

Procedure

1. In the VMware vSphere client tree, click the root element (that is,
the ESX/ESXi server), and then select the Configuration tab.

192.168.170.3 ¥Mware ESX Server, 3.5.0, 95350

Summary ' Vi i el ST = Configuration

Hardware ¥irtual Machine Startup and Shutdown
Processors Start and Stop Virtual Machines with the system  Enabled
Default Startup Delay 2 minutes
Memory Default Shutdown Delay 2 minutes
Storage
Networking Startup Order
Storage Adapters | Wirtual Machine | Startup | Startup Delay | Shutdown | Shutdown Delay | =
Metwork Adapters Automatic Startup
1 G 170-186 Enabled 120 seconds Power off 120 seconds
Software Manual Startup
G buildkester Disabled 120 seconds Power off 120 seconds
Licensed Features G TechPubs Disabled 120 seconds Power off 120 seconds
Tirne: Configuration G 170-189 Disabled 120 seconds Power off 120 seconds
DLl aod Doutiog G 170-188 Disabled 120 seconds Power off 120 seconds
v Wirtual Machine Startup)Shutdown & 170187 Disabled 120 seconds Power off 120 seconds
VB TR TRt ] 3 T e G 170-185 Disabled 120 seconds Power off 120 seconds
Security Profile G 170184 Disabled 120 seconds Power off 120 seconds
. & 170183 Disabled 120 seconds Power off 120 seconds
Syskem Resource Allocation X
) G 170182 Disabled 120 seconds Power off 120 seconds
Advanced Settings Gh 170181 Disabled 120 seconds Power off 120 seconds
G 170179 Disabled 120 seconds Power off 120 seconds
G 170175 Disabled 120 seconds Power off 120 seconds
G 170-174 Disabled 120 seconds Power off 120 seconds
Gl Mew Virtual Machi,,, Disabled 120 seconds Power off 120 seconds =
Gh 17045 Disabled 120 seconds Power off 120 seconds
& 17n-Ae Nisahled 120 seronds Pruwer aff 12N seronds LI

Figure 2: Configuration Pane

26 NetApp StorageGRID
215-06991_CO0



Prepare Virtual Machines

NetApp StorageGRID
215-06991_CO0

2. Under Software, click Virtual Machine Startup/Shutdown, and click

Properties.
r:-? ¥irtual Machine Startup and Shutdown ﬂ
System Settings
¥ Allows virtual machines to start and stop automatically with the system
Drefault Startup Delay Drefault Shutdown Delay
For each virtual machine, delay startup for: For each virtual machine, delay shutdown for:
120 seconds 120 seconds
[T Cantinue immediately if the YMware Taals start Shutdavn Action: Power aff j
Startup Order
Power on the specified vitual machines when the spstem starts. During shutdown, they will be stopped in the opposite order.
| Wirtual Machine | Startup | Startup Delay | Shutdown | Shutdown Delay | -
Automatic Starbup tave U |
1 G 170-186 Enabled 120 seconds Power off 120 seconds
Any Order ove Down |
Manual Startup _
G buildkester Disabled 120 seconds Power off 120 seconds Edit... |
G TechPubs Disabled 120 seconds Power off 120 seconds
G 170-189 Disabled 120 seconds Power off 120 seconds
G 170-188 Disabled 120 seconds Power off 120 seconds LI
OF I Cancel | Help

Figure 3: Virtual Machine Startup and Shutdown Window

Under System Settings, select Allow virtual machines to start and
stop automatically with the system.

Under Default Startup Delay, leave the start-up delay time at the
default of 120 seconds.

A delay of 120 seconds gives each virtual machine time to start
before the next virtual machine begins the process of starting. This
delay allows for a smoother start-up process that will not overload
the system.

Under Startup Order, in the Manual Startup list select any virtual
machine that hosts an Admin Node or a Gateway Node, and click
Move up to move it to the Automatic Startup list.

Place any Admin Node at the top of the list and any

Gateway Nodes below it in any order. Admin Nodes and
Gateway Nodes are generally NTP primaries. Starting them first
helps prevent timing alarms within the grid when the ESX/ESXi
server restarts.

Move virtual machines that host other grid nodes to the Any Order
list by clicking Move up.

These virtual machines restart in any order.
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FF ¥irtual Machine Startup and Shutdown

System Settings

¥ Allows virtual machines to start and stop automatically with the system

Drefault Startup Delay
For each virtual machine, delay startup for:

120 seconds

[T Cantinue immediately if the YMware Tools start

X
Drefault Shutdown Delay
For each virtual machine, delay shutdown for:
120 seconds
Shutdown Action: Power off j

Startup Order

Power on the specified vitual machines when the spstem starts. During shutdown, they will be stopped in the opposite order.

Move Up |
Move Down |

Exdit.... |

| Wirtual Machine | Startup | Startup Delay | Shutdown | Shutdown Delay | -

Automatic Starbup
Any Order

G 170-186 Enabled 120 seconds Power off 120 seconds

G buildkester Enabled 120 seconds Power off 120 seconds
Manual S-I:artup

G TechPubs Disabled 120 seconds Power off 120 seconds |

G 170-189 Disabled 120 seconds Power off 120 seconds

G 170-188 Disabled 120 seconds Power off 120 seconds LI

[ o 1]

Cancel | Help

Figure 4: Move Virtual Machines to Control Startup Order

7. Click OK.

Start the Virtual Machines

28

Prerequisites

¢ All virtual machines have been configured for automatic restart.

Procedure

1. In the vSphere client, select the virtual machine.

2. C(Click the Console tab.

3. Click the green Power On button P.

No operating system is available to the virtual machine at this point, so
it attempts to PXE boot and fails with the message “Operating System

not found”.
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Prepare a Virtual Machine for the Primary

Admin Node

Complete the following tasks to prepare a virtual machine for the

primary Admin Node.
Table 6: Prepare a Virtual Machine for the Primary Admin Node
v/ | Step | Action See
1. Create the provisioning floppy image. page 29
2, Install Linux on the virtual machine for the primary Admin Node. page 30
3. Install VMware Tools and configure VM settings. page 33
4, Load the software distribution. page 34
5. Install the provisioning software. page 37
6. Provision the grid and create a Server Activation USB flash drive. page 38

Create the Provisioning Floppy Image

A Provisioning floppy image contains site-specific information

required to install, integrate, and maintain the StorageGRID system.

Prerequisites

e Utility such as WinImage (available at http://www.winimage.com),

that permits you to create a floppy disk image

*  Grid specification file GID<Grid_ID>_REV1_GSPEC.xml file. See
“Prepare Grid Specification File for Deployment” on page 17.

e provisioning-autoinst-<dn>.xml file

where <dn> is the device name of the system drive, for example
sda. Located in the provisioning directory of the StorageGRID

Software CD or the StorageGRID Software Service Pack CD. Use

the version on the service pack CD if a service pack is available.

¢ Service laptop

Procedure

1. Start the Winlmage software. From the File menu, select New.

¢ In the Format selection dialog, select a standard format 1.44 MB

floppy, and click OK.

NetApp StorageGRID
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2. Create a floppy image that contains the deployment grid specifica-
tion file and the provisioning-autoinst-<dn>.xml file:

a.
b.

C.

From the Image menu, select Inject.
Browse for the grid specification file, and select Open.

When prompted, confirm that you want to inject the file. Select
Yes.

Repeat from step a for the provisioning-autoinst-<dn>.xml file.

where <dn> is the device name of the system drive, for example
sda.

3. Save the floppy image:

a.

b
c.
d

From the File menu, select Save.

. In the Save dialog, browse to the destination folder.

Select Save as type: Virtual floppy Image (*.vfd,*.flp)

. Enter a file name ending in .flp, such as <servername>.fip.

You must enter the extension, or the vSphere client cannot use
the image during installation.

Click Save.

Install Linux on a Virtual Machine for the Primary

Admin Node

30

Use this procedure to install Linux on the virtual machine that will
host the primary Admin Node. The installation process completely
erases the server drives and installs its own OS, applications, and
support files.

Prerequisite

¢ The virtual machine for the primary Admin Node has been started.
See “Start the Virtual Machines” on page 28.

e SLES DVD. For information on the supported version of SLES, see
the Interoperability Matrix Tool (IMT).

¢ Provisioning floppy image. See “Create the Provisioning Floppy
Image” on page 29.

Procedure

1. Insert the SLES DVD into the machine from which you are running
the vSphere client. Skip this step if you are using an ISO image of
Linux.

NetApp StorageGRID
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2. In the VMware vSphere client navigation tree, select the virtual
machine.

3. C(lick the Connect/Disconnect CD/DVD drive to the virtual machine icon,
then select Connect CD/DVD 1 » Connect to <CD_drive_letter>

If you are using an ISO image of the Linux installation, select
Connect CD/DVD 1 » Connect to ISO image on local disk.

Click the Console tab.
5. Click anywhere inside the Console pane to enter the Console pane.

Your mouse pointer disappears.

TiP Press <CtrI>+<Alt> to release your mouse pointer from the VM
console.

6. Press <CtrI>+<Alt>+<Insert> to reset the virtual machine. The server
performs the following steps:

¢ The BIOS runs a hardware verification.

* By default the system boots from the DVD, and loads the SUSE
Linux Enterprise Server Boot Screen in the VMware vSphere
client Console pane.

| Getting Started | Summary | ResourceAllocation | Performance | Tasks &Events | Alarms |[EERAIL Permissions | Maps | Storage Views | NetApp

Boot from Hard Disk
Repair Installed System
Rescue System

Check Installation Media
Firmware Test

Memory Test

Boot Options

F1 Help F2 Language F3 Video Mode F4 Source F5 Kernel F6 Driver
English (US) 800 x 600 CD-ROM Default No

Figure 5: SLES Boot Screen
7. From the SLES Boot Screen:

a. Press the keyboard’s down arrow and highlight Installation.
(Do not press <Enter>.)

NetApp StorageGRID 31
215-06991_CO0



Installation Guide

32

NOTE You must move the cursor to the Installation option within eight

seconds. If you do not, SLES will automatically attempt to install
from the hard drive and the installation process will fail. If this
happens, you must begin the installation process again from the
beginning.

Press <Ctrl>+<Alt> to leave the Console pane.

The mouse icon disappears.

Click Connect Floppy 1 and select Connect to Floppy Image on
local disk.

On your service laptop, select the floppy image that contains
the activation file for this server.

Click anywhere inside the Console pane to return to the Console
pane.

Press <Tab>. At the bottom of the screen, adjacent to the Boot
Options prompt, enter:
autoyast=device://£40/provisioning-autoinst-<dn>.xml
where <dn> is the device name of the system drive, for example
sda.

NOTE If you do not enter the path to the activation file when required,

AutoYaST does not customize the installation for the server.
Always enter the path to the activation file.

If you enter an incorrect value, and are prompted to re-enter
the device name and path, check the floppy device name.

Press <Enter>.

Wait about one minute while the installer processes the
information.

The base SLES installation completes without further
intervention.

During this installation process, disconnect the floppy image after
it is no longer required. Click the Connect/Disconnect the floppy
devices of the virtual machine icon and select Disconnect Floppy 1 »
Disconnect from <drive>.

NOTE If the floppy image is connected when the virtual machine

reboots, the message “This is not a bootable disk is displayed.”
To continue, disconnect the floppy image and hit any key to
continue.

NetApp StorageGRID
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When SLES installation is complete, the server completes its configura-
tion and starts the operating system. Installation is complete when the
login prompt appears.

Install VMware Tools and Configure VM Settings

NetApp StorageGRID
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Install VMware Tools on each virtual machine that will host a grid
node. For information on the supported versions of VMware software,
see the Interoperability Matrix Tool (IMT).

Install VMware Tools from an ISO image that is packaged with
vSphere client software.

The vmware_setup.py script configures the video resolution settings
that the virtual machine uses on startup. This is necessary because the
default resolution is not supported by the VMware video adapter,
which results in an error on startup.

Prerequisites

¢ Linux has been installed on the virtual machine

Procedure

1. In the Virtual Machine tree, right-click the virtual machine, then
select Guest P> Install/ Upgrade VMware Tools.

The Install VMware Tools dialog appears.
2. Select Interactive Tool Upgrade and click OK.

The VMware Tools package is made available to the virtual
machine as an ISO at /cdrom.

Wait until VMware disconnects the Linux CD/DVD.

3. In the VMware vSphere Client, click in the Console pane of the
virtual machine and log in to the host that will be the new grid
node.

4. Copy the VMware Tools packages to the virtual machine:
a. Mount the ISO image of the VMware Tools CD. Enter:
mount /cdrom

b. Copy the gzip package from the CD to the virtual machine, and
unpack it. Enter:
mkdir /tmp/vmtools
cd /tmp/vmtools
tar -zxvf /cdrom/VMwareTools-*.tar.gz
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5. Install VMware Tools, accepting the default installation options.
Enter:

cd /tmp/vmtools/vmware-tools-distrib/
./vmware-install.pl --default

Wait for the installation to complete. This takes about a minute.
6. Check to make sure that VMware Tools is running. Enter:

/etc/init.d/vmware-tools status

You will see the message “vmtoolsd is running”.

7. Remove the installation files from the virtual machine. Enter:
cd /tmp

rm -rf vmtools

8. Run the vmware_setup.py script. Enter: vimware_setup.py
The script completes silently.

9. Reboot to ensure the changes take effect. Enter: reboot

Load Installation ISOs

34

Use the load_cds.py script to load installation ISOs onto the primary
Admin Node. For background on the load_cds.py script, see “About
load_cds.py” on page 117.

This section contains two procedures:
e “Use load_cds.py with CDs on a Virtual Machine” on page 34
e “Use load_cds.py with ISOs” on page 36

Use load_cds.py with CDs on a Virtual Machine

Follow this procedure if installing the primary Admin Node on a
virtual machine.

Prerequisites

e Linux has been installed on the primary Admin Node. See “Install
Linux on a Virtual Machine for the Primary Admin Node” on
page 30.

¢ Service laptop running vSphere Client

¢ The following StorageGRID CDs:
+  StorageGRID 9.0.0 Software CD
* Enablement Layer for StorageGRID 9.0.0 Software CD
 If available, StorageGRID 9.0.x Software Service Pack CD

NetApp StorageGRID
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+ If available, Enablement Layer for StorageGRID 9.0.x Software

Service Pack CD
¢ Any additional CDs required for the grid, such as TSM client
packages CD
Procedure

NOTE The order in which CDs are loaded does not matter.

1. In vSphere Client, click in the console window of the primary
Admin Node’s virtual machine. Log in as root. When prompted for
a password, press <Enter>.

2. Insert the latest StorageGRID Software CD in the service laptop.

If available, use the StorageGRID 9.0.x Software Service Pack CD.
Otherwise, use the StorageGRID 9.0.0 Software CD.

TP Press <CtrI>+<Alt> to release the mouse pointer from the VM console.

3. Click the Connect/Disconnect CD/DVD drive to the virtual machine icon,
then select Connect CD/DVD 1 » Connect to <CD_drive_letter>

4. Install the load_cds.py script:
a. Mount the latest CD.
Enter: mount /cdrom
b. Install the updated load_cds.py script from the CD.
Enter: /cdrom/install-load-cds
c. Unmount the CD. Enter: umount /cdrom
5. Load the first CD. Enter: 10ad_cds.py

Wait while the ISO image of the CD is written to the correct
directory.

6. When asked “Would you like to read another CD?” [Y/N]:
a. Insert the next CD in the service laptop.

b. In the vSphere client, click the Connect/Disconnect CD/DVD icon
and then select Disconnect CD/DVD 1.

c. Connect the next CD. Select Connect CD/DVD 1 » Connect to
<CD_drive_letter>.

d. Click in the vSphere console window.

e. Typey, and press <Enter>.
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7. Repeat step 6 for all CDs. The order in which CDs are loaded does
not matter.

To exit, type n and press <Enter> when prompted.

Log out. Enter: exit

The next step is to install the provisioning software. See “Install the
Provisioning Software” on page 37.

Use load_cds.py with ISOs

Use this procedure to load the ISOs if you have already copied ISO
images of the installation CDs to the primary Admin Node. For
example, you can use this procedure when the server is at a remote
site, and you used scp to copy the files.

NOTE Do not put the ISO images in the /var/local/install directory of the
primary Admin Node. Use any other directory instead, for example,
/var/local/tmp. The load_cds.py script copies files from the directory
that you specify to the /var/local/install directory.

Prerequisites

e Linux has been installed on the primary Admin Node. See “Install
Linux on a Virtual Machine for the Primary Admin Node” on
page 30.

¢ ISO images of the following CDs are on the primary Admin Node
server:

+  StorageGRID 9.0.0 Software
* Enablement Layer for StorageGRID 9.0.0 Software
+ If available, StorageGRID 9.0.x Software Service Pack

+ If available, Enablement Layer for StorageGRID 9.0.x Software
Service Pack

* Any additional CDs required for the grid, such as the TSM
client packages CD

Ensure that the ISO files are correct. The load_cds.py command
does not perform any validation.
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Procedure

NOTE The order in which ISO images are loaded does not matter.

1. Log in the primary Admin Node as root. When prompted for a
password, press <Enter>.

Remove any USB flash drives from the server.

Install the load_cds.py script from the latest StorageGRID software
CD. If available, use the StorageGRID 9.0.x Software Service Pack
CD. Otherwise, use the StorageGRID 9.0 Software CD.

a. Mount the latest CD. Enter:
mount -o loop,ro <iso service_ pack CD including path> /cdrom
b. Install the updated load_cds.py script from the CD.
Enter: /cdrom/install-load-cds
c. Unmount the CD. Enter: umount /cdrom

4. Load the ISO images. Enter on one line:

load _cds.py <iso software CD including path>

<iso enablement_ layer CD including path>

<iso enablement_ layer service_pack CD including path>
<iso software service_pack CD _including path>

<iso other CD including path>

Separate ISO file names with a space. The order does not matter.

Wait until the ISO images are written to the correct directory.

The next step is to install the provisioning software. See “Install the
Provisioning Software” below.

Install the Provisioning Software

Prerequisites

e ISOimages of the software CDs have been loaded onto the primary
Admin Node using load_cds.py. See “Load Installation ISOs” on
page 34.

Procedure

1. At the primary Admin Node server, log in as root. When prompted
for a password, press <Enter>.
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If there is no service pack, mount the StorageGRID 9.0.0 Software
CD image. Enter:

mount -o loop,ro /var/local/install/Bycast_\
StorageGRID_9.0.0_Software_<buildnumber>.iso /cdrom

If there is a service pack, mount the StorageGRID 9.0.x Software
Service Pack image. Enter:

mount -o loop,ro /var/local/install/Bycast_\
StorageGRID_9.0.<servicepacknumber>_\
Software_Service_Pack_<buildnumber>.iso /cdrom

Load the provisioning software. Enter:

/cdrom/load-provisioning-software

When prompted, read and accept the NetApp StorageGRID
Licensing Agreement.

When prompted, confirm that the current time is within ten
minutes of the time displayed. If not, set the system date and time
in UTC time using the format YYYY-MM-DD-hh-mm.

WARNING Make sure that you verify the time displayed. Provi-

sioning may fail if the displayed time is not within 10
minutes of the current time.

To determine the difference between local time and UTC time, use
UTC Time conversion tools available on the internet, for instance
thetimeNOW at http://www.thetimenow.com/index.cgi.

The official current UTC time is available from the International
Bureau of Weights and Measures (BIPM) at http://www.bipm.org/
en/scientific/tai/time_server.html.

The next step is to provision the grid. See “Provision the Grid and
Create Server Activation Floppy Image” below.

Provision the Grid and Create Server Activation Floppy

Image

38

Provisioning is the process of turning a grid design into the collection
of files needed to create, expand, and upgrade the grid. This collection
of files is known as the gpt (grid provisioning tool) repository and
includes the SAID (Software Activation and Integration Data) package.
For more information on provisioning and the SAID package, see
Appendix A, “Grid Specification Files and Provisioning”.
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Prerequisites
¢ Provisioning software has been installed. See “Install the Provision-
ing Software” on page 37.
¢ The following materials are available:
+ Provisioning floppy image. See “Create the Provisioning Floppy
Image” on page 29.
 autility such as WinImage (available at http://www.winim-
age.com), that permits you to create a floppy disk image
* atool such as WinSCP (available at http://winscp.net/eng/down-
load.php) to transfer files to and from the primary Admin Node

+  Service laptop

Procedure

1. At the primary Admin Node, log in as root. When prompted for a
password, press <Enter>.

2. InvSphere Client, connect the Provisioning floppy image by clicking
the Connect/Disconnect the floppy devices of the virtual machine icon and
selecting Connect Floppy 1 » Connect to <drive>.

3. Click in the vSphere console window to return to the command line.
Copy the GID<Grid_ID>_REV1_GSPEC.xml file from the Provisioning
floppy image to the primary Admin Node:

a. Mount the floppy image. Enter: mount /media/floppy
b. Copy its contents to the Admin Node. Enter:

mkdir /root/usb
cp /media/floppy/* /root/usb

c. Unmount the floppy image. It is no longer needed. Enter:
umount /media/floppy

5. Provision the grid:
a. Enter: provision /root/usb
b. When prompted, enter a secure provisioning passphrase.

c. Write down the provisioning passphrase for future reference.
This passphrase is required for most installation and mainte-
nance procedures.

WARNING Make sure that the passphrase is stored in a secure
place and is available for future reference.

d. When prompted, re-enter the provisioning passphrase.
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When the process is complete, “Provisioning complete” is displayed.

For example:

linux:/var/local/tmp # provision /root/usb
Please set a new passphrase for the GPT encrypted repository.
It must be at least 6 characters.
Enter passphrase:
Enter passphrase again:
Provisioning
Grid 400052 has been provisioned for software version: 9.0.0
Revision number 1 for Grid 400052
Created Sat Jan 07 18:09:42 UTC 2012, by the user: provision
Ensuring all certificates exist.
creating grid CA cert
creating grid 1ldr recovery keys
creating grid task keys
creating new node certs on server: agcs-190-39
creating new node certs on server: gcs-190-40
generating host ssh keys for: agcs-190-39

generating the root user's ssh keys for ssh-access point: agcs-190-39

generating host ssh keys for: gcs-190-40

generating the root user's ssh keys for ssh-access point: gcs-190-40

creating new nms cert on server: agcs-190-39
Creating server staging area and placing some files in it.
Creating Gator config file.
Running Gator.
Creating SAID staging area and copying files into it.
Running SPT to create Autoyast files.
running spt for agcs-190-39
running spt for gcs-190-40
Creating SAID file.
Finished creating revision Sat Jan 07 18:10:58 UTC 2010.

* Kk *

*** Please log out and log back in because the hostname has changed.

* k%

*** Warning: Do not log out of the Admin Node before extracting the
*** Pagswords.txt file from the SAID package. You require the Admin
*** Node password from Passwords.txt to log back into the server.

* Kk x

No grid tasks to run

Saving GPT Repository...done

Copying GID400052_REV1_SAID.zip to USB key...done
Copying repository backup to USB key...done
Provisioning complete.

If provisioning ends with an error message, see “Provisioning
Troubleshooting” on page 105.

The SAID package was written to the /root/usb directory.

WARNING Do not log out of the Admin Node until you have trans-

ferred the SAID package to the service laptop. You
need the Passwords.txt file from the SAID package to
log back in.
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6. Unzip the GID<grid_ID>_REV1_SAID.zip file from the /root/usb direc-

tory to retrieve the Passwords.txt file. Then use the Admin Node
password and WinSCP to copy the zip file from the Admin Node
to your service laptop.

Alternatively, unzip the SAID on the Admin Node server and
transfer the Passwords.txt file, the Configuration.txt file, and the
contents of the Doc directory from the Admin Node to your service
laptop using a floppy image. (The entire SAID file is usually too
large to fit in a floppy image.) Create the floppy image on your
service laptop as /media/floppy, connect to it in the vSphere client,
and mount it under Linux. Copy the files to the image, unmount it,
and then extract the images to your laptop.

Unzip the GID<grid_ID>_REV1_SAID.zip file on your service laptop,
and review the contents of the Doc/Index.html file to confirm the
grid is configured correctly. For more information, see “About the
SAID Package” on page 87.

WARNING You must confirm that the SAID package is correct

before proceeding. If errors are discovered later, you
will have to start the provisioning process from the
beginning. This includes re-installing any installed
grid nodes and may take several days.

If you discover any errors, you must reinstall the primary
Admin Node from the beginning. Go back to “Next Steps” on
page 22.

Create the Server Activation media that contains the server activa-
tion files that are used to install Linux on each remaining server
and customize the server for its assigned grid node role.

For grid nodes installed on a VM, create Server Activation floppy
images:
a. Start the Winlmage software. From the File menu, select New.

b. In the Format selection dialog, select a standard format 1.44 MB
floppy. Click OK.

c. Copy one or more server activation files to the floppy image:
*  From the Image menu, select Inject.

*  Browse to the Grid_Activation directory of the unzipped
SAID package and select a server activation file.

e Add additional activation files if desired. Three or four acti-
vation files should fit on a single floppy image.
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d. Save the floppy image(s) with a descriptive name, and a file
name ending in .flp.

*  From the File menu, select Save.
*  Select Save as type: Virtual floppy Image (*.vfd,*.fip)
* Enter a file name ending in flp, such as <servername>.fip.

You must enter the extension, or the vSphere client cannot
use the image during installation.

+  Click Save.
e. Repeat until all server activation files are on floppy images.
9. Return to the Admin Node server, and log out.

When you log back in to the Admin Node, the server has been
assigned a hostname, and uses the password recorded in the Pass-
words.txt file.

10. Back up the provisioning data to a directory on the Admin Node.
This backup copy can be used to restore the grid in the case of an
emergency or during an upgrade or grid expansion.

a. Log in to the primary Admin Node as root with the password
listed in the Passwords.txt file.

b. Create a directory for the backup provisioning data. Enter:
mkdir -p /var/local/backup

c. Back up the provisioning data. Enter:
backup-to-usb-key /var/local/backup

d. When prompted, enter the provisioning passphrase.

11. Store the Provisioning directory and the Backup Provisioning direc-
tories separately in a safe place. For example, use WinSCP to copy
these directories to your service laptop, and then store them to two
separate USB flash drives that are stored in two separate, secure
physical locations. For more information, see “Preserving Copies of
the Provisioning Data” on page 104.

The contents of the Provisioning directory is used during expansion
and maintenance of the grid when a new SAID package must be
generated.

WARNING Store copies of the Provisioning directory in two
separate and secure locations. The Provisioning direc-
tories contain encryption keys and passwords that can
be used to obtain data from the grid. The Provisioning
directory is also required to recover from a primary
Admin Node failure.
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Prepare Virtual Machines for all Other Grid Nodes

Complete the following tasks to prepare virtual machines for all other
grid nodes.

Table 7: Prepare Virtual Machines for All Other Grid Nodes

v/ | Step | Action See
1. Install Linux on virtual machines. page 43
2, Install VMware Tools and configure VM settings. page 46
3. Configure Storage Nodes for NFS storage volumes. page 47

Install Linux on Virtual Machines

Use this procedure to install Linux on all virtual machines in the grid
except, the virtual machine for the primary Admin Node.

Prerequisites

The virtual machine for the grid node has been started. See “Start
the Virtual Machines” on page 28.

SLES DVD. For information on the supported version of SLES, see
the Interoperability Matrix Tool (IMT).

Server Activation floppy image. See “Provision the Grid and
Create Server Activation Floppy Image” on page 38.

Procedure

1.
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Insert the SLES DVD into the machine from which you are running
the vSphere client. Skip this step if you are using an ISO image of
Linux.

In the VMware vSphere client navigation tree, select the virtual
machine.

Click the Connect/Disconnect CD/DVD drive to the virtual machine icon,
then select Connect CD/DVD 1 » Connect to <CD_drive_letter>

If you are using an ISO image of the Linux installation, select
Connect CD/DVD 1 » Connect to ISO image on local disk.

Click the Console tab.
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5. Click anywhere inside the Console pane to enter the Console pane.

Your mouse pointer disappears.

TiP Press <CtrI>+<Alt> to release your mouse pointer from the VM
console.

6. Press <CtrI>+<Alt>+<Insert> to reset the virtual machine. The server
performs the following steps:

¢ The BIOS runs a hardware verification.

* By default the system boots from the DVD, and loads the SUSE
Linux Enterprise Server Boot Screen in the VMware vSphere
client Console pane.

| Getting Started | Summary | Resource All ormance | Tasks & Events | Alarms [[EERIE. Permissions | Maps | Storage

Boot from Hard Disk
Repair Installed System
Rescue System

Check Installation Media
Firmware Test

Memory Test

Boot Options

F1 Help F2 Language F3 Video Mode F4 Source F5 Kernel F6 Driver
English (US) 800 x 600 CD-ROM Default No

Figure 6: SLES Boot Screen
7. From the SLES Boot Screen:

a. Press the keyboard’s down arrow and highlight Installation.
(Do not press <Enter>.)

NOTE You must move the cursor to the Installation option within eight
seconds. If you do not, SLES will automatically attempt to install
from the hard drive and the installation process will fail. If this
happens, you must begin the installation process again from the
beginning.

b. Press <CtrI>+<Alt> to leave the Console pane.

The mouse icon disappears.
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Click Connect Floppy 1 and select Connect to Floppy Image on
local disk.

On your service laptop, select the floppy image that contains
the activation file for this server.

Click anywhere inside the Console pane to return to the Console
pane.

Press <Tab>. At the bottom of the screen, adjacent to the Boot
Options prompt, enter:
autoyast=device://£40/<servername>-autoinst.xml

where <servername> is the server name used to name the acti-
vation file.

NOTE If you do not enter the path to the activation file when required,

AutoYaST does not customize the installation for the server.
Always enter the path to the activation file.

If you enter an incorrect value, and are prompted to re-enter
the device name and path, check the floppy device name.

Press <Enter>.

Wait about one minute while the installer processes the
information.

The base SLES installation completes without further
intervention.

During this installation process, disconnect the floppy image after
it is no longer required. Click the Connect/Disconnect the floppy
devices of the virtual machine icon and select Disconnect Floppy 1 »
Disconnect from <drive>.

NOTE If the floppy image is connected when the virtual machine

reboots, the message “This is not a bootable disk is displayed.”
To continue, disconnect the floppy image and hit any key to
continue.

When SLES installation is complete, the server completes its configura-
tion and starts the operating system. Installation is complete when the
login prompt appears.

For the next step, see “Install VMware Tools and Configure VM Set-
tings” on page 46.
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Install VMware Tools and Configure VM Settings

Install VMware Tools on each virtual machine that will host a grid
node. For information on the supported versions of VMware software,
see the Interoperability Matrix Tool (IMT).

Install VMware Tools from an ISO image that is packaged with
vSphere client software.

The vmware_setup.py script configures the video resolution settings
that the virtual machine uses on startup. This is necessary because the
default resolution is not supported by the VMware video adapter,
which results in an error on startup.

Prerequisites

¢ Linux has been installed on the virtual machine

Procedure

1. In the Virtual Machine tree, right-click the virtual machine, then
select Guest P Install/ Upgrade VMware Tools.

The Install VMware Tools dialog appears.
2. Select Interactive Tool Upgrade and click OK.

The VMware Tools package is made available to the virtual
machine as an ISO at /cdrom.

Wait until VMware disconnects the Linux CD/DVD.

3. Inthe VMware vSphere Client, click in the Console pane of the
virtual machine and log in to the host that will be the new grid
node.

4. Copy the VMware Tools packages to the virtual machine:
a. Mount the ISO image of the VMware Tools CD. Enter:

mount /cdrom
b. Copy the gzip package from the CD to the virtual machine, and
unpack it. Enter:
mkdir /tmp/vmtools
cd /tmp/vmtools
tar -zxvf /cdrom/VMwareTools-*.tar.gz
5. Install VMware Tools, accepting the default installation options.
Enter:
cd /tmp/vmtools/vmware-tools-distrib/

./vmware-install.pl --default

Wait for the installation to complete. This takes about a minute.
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6. Check to make sure that VMware Tools is running. Enter:

/etc/init.d/vmware-tools status

You will see the message “vmtoolsd is running”.

7. Remove the installation files from the virtual machine. Enter:
cd /tmp

rm -rf vmtools

8. Run the vmware_setup.py script. Enter: vimware_setup.py
The script completes silently.

9. Reboot to ensure the changes take effect. Enter: reboot

Configure Storage Nodes for NFS Storage Volumes

NetApp StorageGRID
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Use this procedure to configure the server for the installation of a
Storage Node integrated with NFS mounted storage volumes.

Prerequisites
e The NetApp storage system has been set up and exported via NFS.

NOTE Configuration of the NFS server is beyond the scope of this
guide.

* NFS mounted storage volumes are integrated with the
Storage Node as described in the the Administrator Guide.

* Ensure that you have the IP address of the NFS server.

Procedure

1. Log in to the Storage Node server as root, using the password
provided in the Passwords.txt file.

Verity connectivity to the NFS server. Enter: ping <NFs_server_rp>

3. Verity that the Linux NFS client package is present (it should be
installed by default). Enter:

e ForSLES11: rpm -qg nfs-client
e ForSLES 10: rpm -q nfs-utils
4. Mount the NFS exports:

a. At the Storage Node server, using a text editor such as vi, add
this line to the /etc/fstab file for each storage volume (on one
line):
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<NFS Server IP>:<volume_path> /var/local/rangedb/<next_index>
nfs rw,rsize=65536,wsize=65536,nfsvers=3,tcp

where:
* <NFS_Server_IP>is the IP address of the NFS server

* <volume_path> is the path of the storage volume exported
from the NFS server

* <next_index> is the Storage Node rangedb, a number
between 0 and 15 in hexadecimal notation (0 to F, case-spe-
cific). For the first storage volume, the index number is 0.

For example:

192.168.130.16:/vol/voll /var/local/rangedb/0 nfs
rw,rsize=65536,wsize=65536,nfsvers=3, tcp

Repeat step a for each storage volume.

b. Create a mount point for each NFS storage volume, using the
same index numbers used in the etc/fstab file in step a. Enter:

mkdir -p /var/local/rangedb/<next_available index>

For example:

mkdir -p /var/local/rangedb/0

Do not create mount points outside of /var/local/rangedb.
Repeat step b for each storage volume.

c. Mount the storage volumes to the mount points. Enter:
mount -a
If mounting fails, make sure that the storage volumes are con-
figured on the NFS server for read-write access to the

Storage Node and that the IP address of the Storage Node
supplied to the NFS server is correct.

Troubleshooting

48

This section includes troubleshooting topics to help you identify and

solve problems that may occur while preparing virtual machines. See
also “Provisioning Troubleshooting” on page 105 and “GDU Trouble-
shooting” on page 115.

If problems persist, contact Support. You may be asked to supply the
following installation log files:

* /var/local/log/install.log (found on the server being installed)

* /var/local/log/gdu-console.log (found on the primary Admin Node)

NetApp StorageGRID
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Virtual Machine Not Started
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If a virtual machine does not start after you create it, see “VM Resource
Reservation Requires Adjustment” on page 49.

If a virtual machine does not restart after VMware ESX/ESXi is
restarted, see “VM is Not Configured for Automatic Restart” on
page 49.

VM Resource Reservation Requires Adjustment

The OVF files created by Grid Designer include a resource reservation
designed to ensure that each grid node has sufficient RAM and CPU to
operate efficiently. If you create virtual machines by deploying these
OVF files on ESX/ESXi and the predefined number of resources are not
available, the virtual machines will not start.

If you are certain that the VM Host has sufficient resources for each
grid node, manually adjust the resources allocated for each virtual
machine, and then try starting the virtual machines.

1. In the VMware vSphere client tree, select the virtual machine that
is not started.

Right-click the virtual machine, and select Edit Settings...

3. From the Virtual Machines Properties window, select the Resources
tab.

4. Adjust the resources allocated to the virtual machine:

a. Select CPU, then use the Reservation slider to adjust the MHz
reserved for this virtual machine.

b. Select Memory, then use the Reservation slider to adjust the MB
reserved for this virtual machine.

5. Click OK.

Repeat as required for other virtual machines hosted on the same
VM Host.

VM is Not Configured for Automatic Restart

If the virtual machine does not restart after VMware ESX/ESXi is
restarted, it is most likely that the virtual machine has not been config-
ured for automatic restart.

1. In the VMware vSphere client tree, select the virtual machine that
is not started.

49



Installation Guide

[ 192.168.120.75 - ¥Mware Infrastructure Client

Bl -0 =]

File Edit View Inventory Administration Plugins Help

0
T | g il o ¥
Inventom Scheduled Tasks Ewvents Administration aps Conzolidation

@ B | o B @| I3 connect Floppy 1 O Connect CO/DWD 1 ‘ @I n§|| =

] E Hosts & Clusters
= [ Bycast
ﬂ chinook (RT) GieMting Started QLN o S Hams [T
= @ 192.168.170.3 close tab [X] Al
=@ #owss What is 2 Virtual Machine?
5 [ '

A virtual machine is a software computer that, like a
physical computer, runs an operating system and
applications. An operating system installed on a virtual ) o
machine is called a guest operating system. Nk

Virtual Machines

Because every virtual machine is an isolated computing Cluster : A
environment, you can use virtual machines as desktop or

workstation environments, as testing environments, or to g i
consolidate server applications.

In VirtualCenter Server, virtual machines run on hosts or
clusters. The same host can run many virtual machines.

&/ Datacenter
VirtualCenter

Basic Tasks VI Client

[ Power on the virtual machine

(% Edit virtual machine settings

Explore Further

=l Learn more about virtual machines

K| ] @ =| Learn how to install an operating system

|
Recent Tasks X
Narne: | Target | Status | Tnitiated by = Time | Start Time | Complete Time |
@ Initialize powering on Brycast & Completed RI 11/25/2008 3:23:41 P 11/25/2008 3:23:41 .., 11j25/2008 3:23:41 ...
] Tasks @ Alams | Rl

Figure 7: Virtual Machine Manual Restart

2. In the Getting Started pane, under Basic Tasks, click Power on the
virtual machine.

3. Configure the virtual machine to restart automatically. See “Con-
figure ESX/ESXi for Automatic Restart” on page 26.

Next Steps

Your next step is to install grid software on the prepared virtual
machines. See Chapter 4: “Install and Start Grid Software”.
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Install and Start Grid
Software

How to install and then start StorageGRID software in
the correct order

Verify Networking

Before you install grid software, verify networking to confirm that the
primary Admin Node can communicate with the other servers in the
grid.

Install Grid Software

Use the following procedure to install grid software on all virtual
machines in the following order: primary Admin Node, one
Control Node, and then the remaining grid nodes.

You must install the primary Admin Node first because the primary
Admin Node provides the provisioning environment for the grid. Pro-
visioning is the process of turning a grid design into the collection of
tiles needed to create, expand, or upgrade that grid. This collection of
files is referred to as the gpt (grid provisioning tool) repository.

Control Nodes require extensive database initialization that can take
approximately three hours to complete, which is much longer than
other servers.

You can install grid software on multiple servers in parallel to reduce
the total time required to install the grid.

Prerequisites

e There is connectivity between the primary Admin Node and the
other servers. If there is no connectivity to the Admin Node, use

NetApp StorageGRID
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GDU fails with an
error message if
software is being
installed in a virtual
machine and
VMTools have not
been installed.
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GDU to install software on the primary Admin Node and then go
to Appendix C: “Install Grid Software Manually”.

Linux has been installed

VM Tools have been installed and are running on the server. See
“Prepare Virtual Machines” on page 23.

If the server is not at the same site as the primary Admin Node, the
ISO images of the StorageGRID Software CD and the Enablement
Layer for StorageGRID Software CD have been copied to the server
in order to reduce WAN traffic. See “Copy ISO Files in Multi-Site
Environment” on page 117.

Procedure

1.

3.

Start GDU on the primary Admin Node. See “How to Use GDU”
on page 109.

Install the StorageGRID software on the server:

a. Select the server where you want to install the software in the
Servers panel and confirm that its current state is Available.

b. Select Install Software in the Tasks panel, and then select Start
Task in the Actions panel and press <Enter>.

Installation times vary depending on the size of the database
being set up. It can take approximately 45 minutes on
Admin Nodes, three hours on Control Nodes, and up to
three hours on Storage Nodes which have storage installed.
The script completes in less than 10 minutes on other servers.

The script uses configuration data from autoinst.xml files loaded
earlier to identify the role of the server in the grid and the
hardware configuration required. The script next adds or
removes Linux packages as required to customize the operat-
ing system for that node. Finally, if required on this server, the
script sets up the MySQL database.

If the server hosts an LDR service and the provisioning
hardware profile has not specified object store names, the
installation script detects the unallocated drives and formats
the disks.

If the server hosts a Gateway Node, the server reboots auto-
matically as part of the installation process.

If necessary, install drivers for the physical servers onto which the
virtual machines are installed. See “Install Drivers” on page 53.
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Install Drivers

When installing StorageGRID software on supported servers, you may
also need to install drivers. The Enablement Layer CD for Storage-
GRID software may include drivers for supported servers, and you
can use GDU to install drivers included on the Enablement Layer CD.
However, when the Enablement Layer CD excludes required drivers,
you cannot use GDU to install the drivers. You must locate and
manually install the drivers. For information about supported servers,
see the Interoperability Matrix posted on the NetApp Support Site
(http://support.netapp.com/).

It is your responsibility to confirm that the drivers are the most recent
qualified version. For the latest version, see your hardware vendor.

Start Grid Software

NOTE Do not start grid software until instructed to do so. Grid software can
be started after you install the primary Admin Node, install one
Control Node, and load NMS configuration settings.

After the grid software has been installed, start the grid software using
GDU. Begin with the primary Admin Node followed by one

Control Node. After the primary Admin Node and one Control Node
are running, you must load the NMS configuration settings and
connect to the NMS MI (management interface) via a web browser to
start monitoring the grid. Finally, start the grid software on the other
servers in the grid.

NetApp StorageGRID 53
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Start Software on Primary Admin Node

Start grid software
with GDU

Start grid software on primary
Admin Node
(Enable Services task)

v

Start grid software on
one Control Node

¥

Load NMS
configuration settings
(Load Configuration task)

i

Monitor grid startup with
NMS MI

v

Start grid software on
remaining servers
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Start the grid software on the primary Admin Node first.

Prerequisites and required materials

If the grid has an HCAC, there is connectivity between the two
Admin Node servers

Grid software has been installed on the server

Procedure

1.

Start GDU on the primary Admin Node if not already running. See
“How to Use GDU” on page 109.

Start the StorageGRID software on the primary Admin Node:

a. Inthe Servers panel, select the primary Admin Node and
confirm that its current state is Available.

b. In the Tasks panel, select Enable Services and then in the
Actions panel select Start Task and press <Enter>. Wait for the
task to complete.

If the primary Admin Node is part of a High Capacity Admin
Cluster (HCAC), start the software on the processing
Admin Node:

a. In the Servers panel, select the processing Admin Node and
confirm that its current state is Available.

b. In the Tasks panel, select Enable Services, and then in the
Actions panel select Start Task and press <Enter>.

Wait for the task to complete.

The next step is to start one of the Control Nodes. See “Start Software
on One Control Node” below.

NetApp StorageGRID
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Start Software on One Control Node

Start grid software
with GDU
Start grid software on primary

Admin Node
(Enable Services task)

v
Start grid software on
one Control Node

A 4
Load NMS
configuration settings
(Load Configuration task)

{

Monitor grid startup with
NMS M1

v

Start grid software on
remaining servers

After you have started the software on the primary Admin Node, start
the software on one Control Node. This is required to bring an ADC
service online.

Prerequisites and required materials

¢ There is connectivity between the primary Admin Node and the
Control Node

e QGrid software has been installed on the server

Procedure

1. Start GDU on the primary Admin Node if not already running. See
“How to Use GDU” on page 109.

2. Start the StorageGRID software on the Control Node:

a. Inthe Servers panel, select the server and confirm that its
current state is Available.

b. In the Tasks panel, select Enable Services, and then in the
Actions panel select Start Task and press <Enter>. Wait for the
task to complete.

The next step is to load the NMS configuration settings. See “Load
NMS Configuration Settings” below.

Load NMS Configuration Settings

Start grid software
with GDU

Start grid software on primary
Admin Node
(Enable Services task)

¥

Start grid software on
one Control Node

v
Load NMS
configuration settings
(Load Configuration task)
v
Monitor grid startup with
S MI

v

Start grid software on
remaining servers
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Loading the NMS configuration settings for the grid can be done any
time after at least one ADC service (the ADC is a service that runs on
Control Nodes) is running. The primary Admin Node uses the ADC to
distribute the required settings to all other grid nodes.

The NMS MI (management interface) allows you to verify that services
are recognized and have joined the grid. Without the NMS MI, you
may not be made aware of network connection or authentication
problems.

Prerequisites
* Grid software has been started on the primary Admin Node
*  Grid software has been started on one Control Node

e Service laptop is available to connect to the NMS MI
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Procedure

1.

Start GDU on the primary Admin Node if not already running. See
“How to Use GDU” on page 109.

Select the primary Admin Node server in the Servers panel and
confirm that its current state is Available.

Select Load Configuration in the Tasks panel, and then select Start
Task in the Actions panel and press <Enter>. Wait for the task to
complete.

Connect to the customer network from the service laptop.

Work with the customer system administrator to establish the
physical network connection to the service laptop. Using the cus-
tomer's network rather than a direct connection within the rack
verifies that the interface is accessible using the same infrastructure
the customer uses.

Launch the web browser.
Ensure that the browser is configured to permit pop-ups.
Go to https://<IP_address>

where <IP_address> is the client-side IP address of the primary
Admin Node. In a grid with an HCAC, use the IP address of the
reporting Admin Node.

Wait for the NMS Log In page to appear. It may take several
minutes after the configuration settings have been loaded.

Log in to the NMS MI using the username Vendor and the
password listed in the Passwords.txt file.

The Grid Overview page appears. All grid nodes and their services
should appear in the Grid Topology tree. Services that have not yet
been started are gray, indicating that they are “Administratively
Down”. As services are started, they assume the color appropriate
to their status.

Some alarms appear during the start-up as new services connect
and locate required components. The alarms clear as the process
continues. Archive Nodes show a major alarm (orange) when they
are first started. This is normal. You must complete the TSM
Archive Node configuration steps described in “Complete Setup of
the TSM Archive Node” on page 62 to clear the alarm.

For detailed information on how to use the NMS M1, see the Grid
Primer.

The next step is to start the grid software on the remaining servers. See
“Start Software on Other Grid Nodes” below.

NetApp StorageGRID
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Start Software on Other Grid Nodes

Start grid software
with GDU

Start grid software on primary
Admin Node
(Enable Services task)

v

Start grid software on
one Control Node

v
Load NMS
configuration settings
(Load Configuration task)

¥

Monitor grid startup with
NMS MI

v

Start grid software on
remaining servers

Next Steps

You can now start the software on the other grid nodes in the grid.

If a site includes a secondary HCAGC, start it before starting the other
grid nodes at that site. This allows the Admin Nodes to start process-
ing data at the earliest possible time, thereby making the databases of
the HCACs more consistent.

Prerequisites

e There is connectivity between the primary Admin Node and the
server

e Grid software has been installed on the server

Procedure

1. Start GDU on the primary Admin Node if not already running. See
“How to Use GDU” on page 1009.

2. Start the StorageGRID software on the server:

a. In the Servers panel, select the server and confirm that its
current state is Available.

b. In the Tasks panel, select Enable Services, and then select Start
Task in the Actions panel and press <Enter>. Wait for the task to
complete.

Close GDU when you no longer need it. See “Close GDU” on
page 114.

Complete Configuration
and Back Up Data

Create file shares, customize
ILM, create FSG backup, etc.

Back up Provisioning Data
(primary Admin Node on a VM)

NetApp StorageGRID
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After you have installed StorageGRID software on all virtual
machines:

* Ensure that you store the provisioning data in two separate, secure
locations. See “Preserving Copies of the Provisioning Data” on
page 104.

e Complete the configuration and customization steps described in
Chapter 5: “Configure the Grid” on page 61.
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Troubleshooting

This section includes troubleshooting topics to help you identify and
solve problems that may occur while installing the StorageGRID soft-
ware. See also “Provisioning Troubleshooting” on page 105 and “GDU
Troubleshooting” on page 115.

If problems persist, contact Support. You may be asked to supply the
following installation log files:

¢ /var/local/log/install.log (found on the server being installed)

¢ /var/local/log/gdu-console.log (found on the primary Admin Node)

Corrupt ISO Message When Using load_cds.py Script

If you get an error message that a corrupt ISO has been detected (for
instance, a failed md5sum check), check the integrity of the CD and
load the CD again.

GDU Fails When Re-running “Install Software” Task

58

If your initial attempt to install software on a grid node fails, GDU may
transition into an error state that will not allow you to successfully
install software.

When you encounter this issue, GDU displays only the Update Status
task for the grid node. After refreshing the display by selecting Update
Status, the Install Software task becomes available again, but subsequent
attempts to install software fail.

To work around this issue, unmount volumes and remove them from
the /etc/fstab file before attempting to install the grid node again.

1. Log in to the grid node as root using the password listed in the
Passwords.txt file.

Check what is mounted on the server. Enter: mount

3. Unmount all storage volumes, FSG mount points, MySQL parti-
tions and/or audit partitions from the server. Enter (as required):
umount /var/local/rangedb/*
umount /fsg
umount /var/local/mysq ibdata

umount /var/local/audit

NetApp StorageGRID
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4. Edit /etc/fstab.
Keep entries for NFS mounted storage and system drives.

Remove the lines for any volumes whose device name includes
“by-uuid” or “fsgvg-fsglv”. For example, remove any lines similar
to the following:

/dev/disk/by-uuid/2a1204d2-db57-4358-b742-142e20d90ec6 /var/local/mysqgl_ibdata
ext3 errors=remount-ro,noatime,barrier=0 0 1

/dev/mapper/fsgvg-fsglv /fsg xfs dmapi,mtpt=/fsg,noalign,nobarrier,ikeep 0 2
/dev/disk/by-uuid/e2ibre68f0-6ed0-41c3-9094-c29e327173ef /var/local/rangedb/0
ext3 errors=remount-ro,dirsync,barrier=0,data=writeback
/dev/disk/by-uuid/e23e444d0-2ccl-85c3-1111-c56£324563cf /var/local/rangedb/1
ext3 errors=remount-ro,dirsync,barrier=0,data=writeback

5. Save /etc/fstab.
6. Return to GDU, and select Update Status for that grid node.
7. Retry the Install Software task.
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Process Overview

After the grid software has been installed, you must complete a
number of configuration steps to enable the grid to work its deploy-
ment environment. Some of the procedures are required to ensure the
grid works correctly; others need only be performed to customize the
grid in a particular way.

Required Grid Configuration

Perform the following procedures to enable the grid to work correctly:

¢ Complete the installation of the TSM Archive Node. See “Complete
Setup of the TSM Archive Node” on page 62.

e Create the first backup of the FSG managed file system to create
initial conditions for future maintenance. See “Create the Initial
FSG File System Backup” on page 72.

¢ If the grid includes a High Availability Gateway Cluster (HAGC),
ensure that it is configured with more than one ping node for

increased stability. For more information, see the Administrator
Guide.

¢ If the primary Admin Node is installed in a virtual machine, ensure
that you have preserved two copies of the provisioning data in
separate locations as described in “Preserving Copies of the Provi-
sioning Data” on page 104.

WARNING You must preserve copies of the provisioning data.
Store copies of the Provisioning directory in two
separate and secure locations. The Provisioning direc-
tories contain encryption keys and passwords that can
be used to obtain data from the grid. The Provisioning
directory is also required to recover from a primary
Admin Node failure.
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Optional Grid Customization

After completing an installation, you can customize the grid as
follows:

¢ Create NMS MI accounts for users and administrators.
¢ Customize the ssh access point for increased security

¢ Configure DNS

¢ Configure e-mail notification for Admin Nodes

¢ Configure SNMP monitoring

¢ Enable deduplication

NOTE Deduplication is deprecated and no longer supported.

* Reconfigure IP addresses
¢ Configure storage compression
¢ Configure the grid’s ILM policy

e Create CIFS or NFS file shares to enable clients to store and retrieve
objects to the grid

For more information and procedures, see the Administrator Guide.

Complete Setup of the TSM Archive Node

The TSM Archive Node is not functional after you complete the instal-
lation of the Archive Node. Before the grid can save objects to the TSM
Archive Node, you must complete the installation and configuration
of the TSM server and configure the Archive Node to communicate
with the TSM server.

For information on optimizing TSM retrieval and store sessions, see
the Administrator Guide.

Install a New TSM Server

62

You can integrate the Archive Node with either a new or an existing
TSM server. In either case, use the information in “Best Practices for
TSM Integration” on page 19 to help plan the integration of the
Archive Node with the TSM server.
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If you are integrating with an existing TSM, skip to “Configure the
TSM Server” below.

If you are installing a new TSM on its own server, follow the instruc-
tions in your TSM documentation to complete the installation. After
installation is complete, go on to “Configure the TSM Server” below.

NOTE An Archive Node cannot be co-hosted with a TSM server.

Configure the TSM Server

NetApp StorageGRID
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This section includes sample instructions for preparing a TSM Server
that follow the recommendations outlined in “Best Practices for TSM
Integration” on page 19. These instructions guide you through the
process of:

e Defining a disk storage pool, and a tape storage pool (if required)
on the TSM server.

¢ Defining a domain policy that uses the TSM management class for
the data saved from the Archive Node, and registering a node to
use this domain policy.

These instructions are provided for your guidance only; they are not
intended to replace TSM Server documentation, or to provide
complete and comprehensive instructions suitable for any customer
configuration. Instructions suitable for your site should be provided
by a TSM administrator who is familiar both with your detailed
requirements, and with the complete set of TSM Server
documentation.

Define Storage Pools

The Archive Node writes to a disk storage pool. To archive content to
tape, the disk storage pool must be configured to move content to a
tape storage pool.

e For a TSM server, you must define a tape storage pool and a disk
storage pool within Tivoli Storage Manager. After the disk pool is
defined, create a disk volume and assign it to the disk pool.

A tape pool is not required if your TSM server uses disk-only storage.

There are a number of steps that must be completed on your TSM
server before you can create a tape storage pool. (Create a tape library
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and at least one drive in the tape library. Define a path from the server
to the library and from the server to the drives, and then define a
device class for the drives.) The details of these steps may vary
depending upon the hardware configuration and storage require-
ments of the site. For more information, see the TSM documentation.

A sample set of instructions are included here: be aware that the
requirements of your site may vary. For configuration details and for
instructions, see the TSM documentation for your server.

You must log onto the server with administrative privileges and use
the dsmadmc tool to execute the following commands.

1.

Create a tape library. Enter:

define library <tapelibrary> libtype=scsi

where <tapelibrary> is an arbitrary name chosen for the tape library,
and the value of libtype may vary depending upon the type of tape
library.

Define a path from the server to the tape library. Enter (on one
line):

define path servername tapelibrary srctype=server
desttype=library device=lib-devicename

where:
 servername is the name of the TSM server
* lib-devicename is the device name for the tape library

Define a drive for the library. Enter:

define drive tapelibrary <drivename>

where you may choose any <drivename> you require.

You may want to configure an additional drive or drives, depend-
ing upon your hardware configuration. (For example, if the TSM
server is connected to a fibre channel switch that has two inputs
from a tape library, you may wish to define a drive for each input.)

Define a path from the server to the drive(s) you defined. Enter (on
one line):

define path servername drivename srctype=server
desttype=drive library=tapelibrary device=drive-dname

where drive-dname is the device name for the drive, and tapelibrary
is the name of the tape library as defined in step 1.

Repeat for each drive that you have defined for the tape library,
using a separate drivename and drive-dname for each drive.

NetApp StorageGRID
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Define a device class for the drives. Enter (on one line):

define devclass DeviceClassName devtype=1lto
library=tapelibrary format=ultrium3

where:

*  DeviceClassName is the name of the device class

* Ito describes the type of drive connected to the server
* tapelibrary is the tape library name defined in step 1

* substitute the appropriate value for ultrium3 in the
format= parameter to match your tape type

Add tape volumes to the inventory for the library. Enter:

checkin libvolume tapelibrary

where tapelibrary is the tape library name defined in step 1 of
“Create a tape library. Enter:” on page 64.

Create the primary tape storage pool. On the TSM server, enter (on
one line):

define stgpool BycastTapePool DeviceClassName
description=description collocate=filespace maxscratch=XX

where:
*  BycastTapePool is the name of the Archive Node’s tape storage

pool. You can select any name for the tape storage pool (as long
as the name uses the syntax conventions expected by the TSM).

e DeviceClassName is the name of the device class name for the
tape library.

* description is a description of the storage pool that can be dis-
played on the TSM server using the ‘query stgpool’ command.
For example: “Tape storage pool for the Archive Node”.

+  Setting collocate to “filespace” specifies that the TSM server
should write objects from the same filespace into a single tape.

*  XXis:
 the number of empty tapes in the tape library (in the case

that the Archive Node is the only application using the
library).

* the number of tapes allocated for use by the StorageGRID
system (in instances where the tape library is shared).
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On a TSM server, create a disk storage pool. At the TSM server’s
administrative console, enter (on one line):

define stgpool BycastDiskPool disk description=description
maxsize=maximum file size nextstgpool=BycastTapePool
highmig=percent_high lowmig=percent_low

where:

*  BycastDiskPool is the name of the Archive Node’s disk pool. You
can select any name for the disk storage pool (as long as the
name uses the syntax conventions expected by the TSM).

*  description is a description of the storage pool that can be dis-
played on the TSM server using the ‘query stgpool’ command.
For example, “Disk storage pool for the Archive Node”.

* maximum_file_size forces objects larger than this size to be
written directly to tape, rather than being cached in the disk
pool. It is recommended to set maximum_file_size to 10 GB.

* nextstgpool=BycastTapePool refers the disk storage pool to the
tape storage pool defined for the Archive Node.

*  percent_high sets the value at which the disk pool begins to
migrate its contents to the tape pool. It is recommended to set
percent_high to 0 so that data migration begins immediately.

*  percent_low sets the value at which migration to the tape pool
stops. It is recommended to set percent_low to 0 to clear out the
disk pool.

On a TSM Server, create a disk volume (or volumes) and assign it
to the disk pool. Enter:

define volume BycastDiskPool volume_name formatsize=size
where:
*  BycastDiskPool is the disk pool name defined above

*  volume_name is the full path to the location of the volume (for
example /var/local/arc/stage6.dsm) on the TSM server where it
writes the contents of the disk pool in preparation for transfer
to tape.

* sizeis the size, in MB, of the disk volume.

For example, to create a single disk volume such that the contents
of a disk pool fill a single tape, set the value of size to 200000 when
the tape volume has a capacity of 200 GB.

However, it may be desirable to create multiple disk volumes of a
smaller size, as the TSM server can write to each volume in the disk
pool. For example, if the tape size is 250 GB, create 25 disk volumes
with a size of 10 GB (10000) each.
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The TSM server preallocates space in the directory for the disk
volume. This can take some time to complete (more than three
hours for a 200 GB disk volume).

Create a Domain Policy and Register a Node

Next, define a domain policy that uses the TSM management class for
the data saved from the Archive Node, and then register a node to use
this domain policy.

NOTE Archive Node processes may leak memory if the client password for
the Archive Node in Tivoli Storage Manager (TSM) expires. Ensure
that the TSM is configured such that the client username/password for
the Archive Node never expires.

When registering a node on the TSM server for the use of the

Archive Node (or updating an existing node), you must specify the
number of mount points that the node can use for write operations by
specifying the MAXNUMMP parameter to the REGISTER NODE
command. The number of mount points is typically equivalent to the
number of tape drive heads allocated to the Archive Node. The number
specified for MAXNUMMP on the TSM server must be at least as large as
the value set for the ARC » Middleware » Configuration » Main »
Maximum Store Sessions for the Archive Node. Which is set to a value of
0 or 1, as concurrent store sessions are not supported by the

Archive Node. For more information, see Table 8 on page 69.

The value of MAXSESSIONS set for the TSM Server controls the
maximum number of sessions that can be opened to the TSM server by
all client applications.The value of MAXSESSIONS specified on the TSM
must be at least as large as the value specified for ARC » Middleware »
Configuration » Main » Number of Sessions in the NMS for the

Archive Node. The Archive Node concurrently creates at most one
session per mount point plus a small number (< 5) of additional
sessions.

TSM Server

The TSM node assigned to the Archive Node uses a custom domain
policy tsm-domain. The tsm-domain domain policy is a modified version
of the “standard” domain policy, configured to write to tape and with
the archive destination set to be the grid’s storage pool (BycastDiskPool).

You must log in to the TSM server with administrative privileges and
use the dsmadmc tool to create and activate the domain policy.
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Create and Activate the Domain Policy

1. Create a Domain Policy. Enter: copy domain standard tsm-domain

2. Determine the name of the Management Class to be used with the
Archive Node:

a. If you are using an existing management class go to step 3.

b. If necessary, create the management class you need. Enter:
define policyset tsm-domain standard
define mgmtclass tsm-domain standard default
where default is the default management class for the grid
deployment (as specified in “Configure the TSM Archive Node”
on page 69) and we first create a policy set called standard.

3. Create a copygroup to the appropriate storage pool. Enter (on one
line):
define copygroup tsm-domain standard default type=archive
destination=BycastDiskPool retinit=event retmin=0 retver=0
where default is the default Management Class for the
Archive Node. The values of retinit, retmin, and retver have been
chosen to reflect the retention behavior currently used by the
Archive Node.

NOTE Do notsetretinitto retinit=create. Setting retinit=create
blocks the Archive Node from deleting content since retention
events are used to remove content from TSM

4. Assign the management class to be the default. Enter:
assign defmgmtclass tsm-domain standard default
5. Set the new policy set as active. Enter:
activate policyset tsm-domain standard

Ignore the “no backup copy group” warning that appears when you
enter the activate command.

6. Register a node to use the new policy set on the TSM. On the TSM
server, enter (on one line):
register node arc-user arc-password passexp=0
domain=tsm-domain MAXNUMMP=number-of-sessions
where arc-user and arc-password are same client node name and
password as you define on the Archive Node, as described in “Con-
figure the TSM Archive Node” on page 69, and the value of
MAXNUMMP is set to the number of tape drives reserved for
Archive Node store sessions (as described on page 71).

Note that by default, registering a node creates an administrative
user ID with client owner authority, with the password defined for
the node).
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Configure the TSM Archive Node

Before the Archive Node can communicate with the TSM middleware
running on the TSM server, you must configure a number of settings in
the NMS MI that permit the Archive Node to recognize it. Until these

settings are made, the ARC service remains in a Major alarm state (as it
is unable to communicate with the TSM).

1.

Access the NMS MI and go to Archive Node » ARC » Middleware »
Configuration » Main.

Use the information in Table 8 to make the appropriate settings.

As a minimum, you need to customize Server IP, Node Name, User
Name, Password, and, depending on the situation, Server Port and
Management Class.

The Number of Sessions, Maximum Retrieval Sessions, and Maximum
Archive Sessions have been selected for the case where you have a
tape library with 2 drives allocated to the Archive Node.

Click Apply Changes.

The Archive Node can now connect to the middleware, and the
alarm on Middleware Connectivity clears within a few minutes.

Table 8: ARC » Middleware Component Configuration Settings

Prompt Type

Description

Middleware Account

Maximum Text
Retrieve
Sessions

The maximum number of concurrent sessions that the ARC can open to
the middleware server to retrieve objects.

In most cases, set Maximum Retrieve Sessions to the

Number of Sessions — Maximum Store Sessions. For example, if the
Number of Sessions is 5, and Maximum Store Sessions has its default
value of 1, then Maximum Retrieve Sessions should be 4.

To share one tape drive for both storage and retrieval, set the Maximum
Retrieve Sessions equal to the Number of Sessions. When there are
multiple tape drives, making this setting optimizes performance when
objects on a Storage Node are being restored from copies on the
Archive Node, or if the archive is full and operating in a read-only
mode.
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Table 8: ARC » Middleware Component Configuration Settings (cont.)

Prompt

Type

Description

Management
Class

Text

The name of the default Tivoli Storage Manager (TSM) management
class (default) assigned to objects by the ARC when it saves them to the
TSM. Middleware management classes outline how the middleware's
backup and archive operations function, and may be used to specify
business rules that are applied by the middleware server. (Such business
rules operate independently of the grid’s business rules, and must be
consistent with the grid’s requirement that objects are stored perma-
nently and are always available for retrieval by the Archive Node.)

The default management class is used if a management class is not spec-
ified for an object when it is saved to the grid (via an FSG Profile as
described in the Administrator Guide, the StorageGRID API (SGAPI),
or CDMI), or if the management class that is specified is not defined on
the TSM middleware server.

If the default management class you specify here does not exist on the
TSM server, then an object saved using this management class is not
stored to the middleware archive. Instead the grid retains the object in a
queue, and increments the value of CMS P Content » Overview »
Objects with ILM Evaluation Pending.

Recall that the name of a TSM management class can include no more
than 30 characters, is not case-sensitive, and can include only the follow-
ing characters:

* alphabetic characters: A - Z
* numerals:0-9

* the following “special” characters: . (period),
- (hyphen), + (plus sign), & (ampersand),
_ (underscore)

Maximum
Store
Sessions

Text

The maximum number of concurrent sessions that the ARC can open to
the middleware server to store objects.

Concurrent store sessions are not supported by the Archive Node. Set
Maximum Store Sessions to 1 when the Archive Node is able to store or
retrieve objects. Set the value to 0 when the archive managed by the mid-
dleware server is full, and the Archive Node can only retrieve objects.

Node Name

Text

Sets the name of the Archive Node, as it appears to the middleware. The
name that you enter here must be the same as the node name (arc-user)
that you registered on the TSM server in “Create a Domain Policy and
Register a Node” on page 67.
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Table 8: ARC » Middleware Component Configuration Settings (cont.)

Prompt

Type

Description

Number of
Sessions

Text

The number of tape drives on the middleware server that are dedicated
to the Archive Node.

Set this value to be the same as the value for MAXNUMMP (maximum
number of mount points) set when the TSM node was registered or
updated. (In the register command, the default value of MAXNUMMP
used is 1, if no value is set.)

The value of MAXSESSIONS for the TSM server must be set to be at
least as large as Number of Sessions set here for the ARC. (The default
value of MAXSESSIONS on the TSM server is 25).

The Archive Node concurrently creates at most one session per mount
point plus a small number (<5) of additional sessions.

Password

Text

The value of the password used by the ARC to log in to the TSM middle-
ware. This is the password for the node (arc-user) that you registered for
the client (arc-password) in “Create a Domain Policy and Register a
Node” on page 67, or the password of the administrative user you
selected for the node.

You are prompted to confirm the password after you enter it.

Server IP

Text

Sets the IP address of the middleware server used by the ARC. The
default value is 127.0.0.1.

Server Port

Text

Sets the value of the port number on the middleware server that the ARC
uses for communications.

The default port used clients (such as the Archive Node) to communi-
cate with the TSM server is 1500.

User Name

Text

The user name of the account that the ARC uses to log in to the middle-
ware. By default, when you register a node, the TSM server creates an
administrative user ID with client owner authority. If you chose to use
this default administrative user, enter the client node name (arc-user) as
the user name.

If you chose to define (or use) a different administrative user for the
node, enter its name here.

Set Custom Alarms for the Archive Node

NetApp StorageGRID
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You should establish custom alarms for the following two attributes
that are used to monitor the speed and efficiency of data retrieval from
the Archive Node:

ARQL - Average Queue Length. The average time, in microseconds,
that an object is queued for retrieval from the middleware.
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* ARRL - Average Request Latency. The average time, in microsec-
onds, needed by the Archive Node to retrieve objects via the
middleware.

The normal values for these attributes (found in the NMS MI under
ARC p» Retrieve) depend heavily on how the middleware and storage is
configured and used by the customer. For the TSM Archive Node, the
values set in the middleware for request timeouts and the number of
sessions made available for retrieve requests are particularly
influential.

After integration is complete, monitor retrieval from the Archive Node
to establish values for normal retrieval times and queue lengths. Then
use the NMS MI to create custom alarms for ARQL and ARRL that will
notify an administrator of abnormal operating conditions that may
require investigation. See the Administrator Guide for the procedure on
how to create custom alarms.

Create the Initial FSG File System Backup

72

To create initial conditions for future maintenance of the managed file
system, the grid must contain a backup of each replication group.
Force an initial file system backup as a safety precaution to ensure you
can recover from any problems that might arise prior to the first sched-
uled backup (the file system is automatically backed up every day
during normal operations).

Perform this procedure for each Gateway Node replication group.

1. Find the FSG designated to perform the backup.

a. Inthe NMS M]I, go to Grid Management » FSG Management »
<Replication_Group> » Overview » Main.

b. Click the link for Backup FSG to go to FSG » Overview » Main.
2. Ensure the backup FSG is running normally:
a. Verify the FSG State attribute reports Online.
Verify the FSG Status attribute reports No Errors.
Go to FSG » Backup » Overview » Main.
Verify that Current Status is Idle.

Verify the Backup Schedule: Next Scheduled Backup is not
imminent.

© o0 T
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Initiate the manual backup:

a. Go to FSG » Backup » Configuration.

b. Select Force Manual Backup.

c. Click Apply Changes.
The FSG now performs the backup, which stores a file into the
grid.

Verify the file system backup:

a. Go to FSG » Backup.

b. Verity the following:

The attribute Successful Backups reports 1 or more. If this
value is zero (0), check the Current Status attribute of the
Current Backup group on this page. If the value is Active,
wait for the backup to complete.

* The Previous Backup section for the Backup Result reports
“Successful”.

* Start Time and End Time report a reasonably current time
indicating the manual backup.

If the backup fails, repeat the process to force a backup and re-
validate.

Check that the backup was stored to the grid:
a. Go to the grid’s Overview page.

b. Verify that the value of the summary attribute Total Managed
Objects reports 1 or more objects stored to the grid, represent-
ing the backup object(s). (There should be one successful
backup for each replication group. If the automatic backup
process began while you were completing grid integration, the
value may be larger than the number of replication groups.)

Alternatively, get the value of the backup object identifier from
FSG » Backup and look up where the backup object has been
stored using <primary Admin Node> » CMN P Object Lookup »
Configuration.

If there is more than one replication group in the deployment,
repeat this procedure for each group. Verify that the number of
backups continues to increment.

Log out of the NMS MI. Click Logout.
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Next Steps
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Continue with the configuration steps listed below.

1. Configure the grid’s ILM policy. For more information, see the
Administrator Guide.

2. Create file system shares. For more information, see the Adminis-
trator Guide.

3. Customize Gateway Node behavior. This includes configuring
content protection, configuring the cache, configuring FSG pro-
files, and so on. For more information, see the Administrator Guide.

4. Configure client-side entities.

5. Verify gateway access. For more information, see Chapter 6:
“Verify Client and Grid Integration”.
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215-06991_CO0



Verify Client and Grid
Integration

Introduction

To complete the integration of a StorageGRID system, you must verify
that the customer’s client workstations can access the grid, store
content, retrieve content, and delete content (content deletion depends
on the grid’s business rules).

Verify Client Access

1. Create NFS and/or CIFS fileshares as described in the Administrator
Guide.

2. Have the customer system administrator perform these tests with
your guidance, using a client (and user account) integrated with
one of the file shares.

3. The system administrator may want to perform this process for all
clients to verify each is correctly integrated.

The test uses source test files that are located on the StorageGRID
Software CD. The client system needs a CD drive to access these test
files.

Test cases must be executed sequentially in order to preserve depen-
dencies between test cases.
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Set up Test

CIFS Integration

Use the following procedure to prepare the integration test if the client
application connects to the StorageGRID system via CIFS shares:

The share name
does not use the
\fsg path.
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1.

If the client computer is using a client-side firewall (such as Zone-
Alarm), ensure that access is enabled to the gateway IP addresses
of the StorageGRID system.

From the client workstation, ping the primary FSG to verify

connectivity:
a. From the Windows start button, select Run.
b. In the Run dialog box, enter: cmd. exe
c. Enter: ping <IP address>
where </P_address> is the client-side IP address of the FSG.
Verity that the server responds, indicating connectivity.
C:~>ping 192.168.128.71
Pinging 192.168.128.71 with 32 hytes of data:
Reply from 192.168.128.71: bytes=32 time=1ims TTL=63
Reply from 192.168.128.71: bytes=32 time{ims TTL=63
Reply from 192.168.128.71: bytes=32 time{ims TTL=63
Reply from 192.168.128.71: bytes=32 time{ims TTL=63
Ping statistics for 192.168.128.71:
Packets: Sent = 4, Received = 4, Lost = B (Bx loss).
Approximate round trip times in milli-seconds:
Minimum = Bms. Maximum = ims. Average = Bms
LR
Figure 8: Sample PING Verification
d. Close the Command Prompt window. Enter: exit
Map a network drive to the share:
a. From the Windows desktop, click My Computer.
b. From the Tools menu, select Map Network Drive.
c. Inthe Drive box, select an unused letter to assign to the Storage-
GRID system gateway folder.
d. In the Folder box, type the CIFS share name in the form:

\\<IP address>\<share name>

where </P_address> is the address used in step 2¢ above and
<share_name> is the share name used for CIFS integration. The
example below shows \\192.168.180.71\myDirectory.
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You may not want to e. Select Reconnect at logon.

reconnect a second- R

ary FSG share at f. Click Finish.

logon. g. If prompted, enter a User name and Password and click OK.

4. Repeat the process for each secondary FSG.

You can now perform the “Test File Ingest” on page 77.

NFS Integration

Use the following procedure to prepare the integration test if the client
application connects to the StorageGRID system via NFS shares. This
test assumes you are at a command shell of a Unix/Linux system.

1. Verify connectivity to the primary FSG. Enter: ping <IP_address>
(or variant for the client system)

where </P_address> is the client-side I address of the
Gateway Node. Verify that the server responds, indicating
connectivity.

2. Mount the primary FSG writable share using a command appro-
priate to the client OS. A sample Linux command is:

mount -t nfs -o hard, intr <IP address>:/fsg/<share> <myGrid>

Use the IP address of the primary FSG and the share name for the
client directory. The mount point can be any name selected by the
client (myGrid in the command above).

3. Repeat the process for each secondary FSG. The mount point must
be distinct from the first primary.

You can now perform the “Test File Ingest” below.

Test File Ingest

To verify that the StorageGRID system allows files to be stored
through a primary FSG file share:

1. At the test workstation, insert the StorageGRID Software CD and
open the testdata directory which contains the test files Sample_X-
Ray.jpg and Sample-MRl.jpg.

2. Login to the NMS ML
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3. Record the number of objects stored in the system on the Overview

Summary page:
* Total Managed Objects
e Total Files Stored to Grid — Successful

= Grid Management

| Overview 'q Alarms Reports Configuration
g Account Management Main Tasks
g FSG Management
: .b‘z; HTTP Management Metadata Capacity
[H-3& Grid Configuration
_‘:5, - gemem Control Nodes Installed 2
‘:’; L Control Nodes Readable 2
o LEETEENET Control Nodes Writable 2
B Grid Topology Installed Metadata Capacity: 365 GB
: ) Used Metadata Capacity: 707 MB
5 ) Regional Archive Available Meatadata Capacity 358 GB

4126 Ohjectsl

_‘ be I otal Managed Objects

¥
Percentage Metadata Capacity Available

s P

98.064 %
APl Operations
CDMI Operations - Rate MAA
CDMI Operations - Successful MAA
CDMI Operations - Failed MAA
CDMI - Received Bytes MAA
CDMI - Transmitted Bytes MAA
Archive Nodes
Archive Nodes Installed 1
Archive Nodes Readable 1
Archive Nodes Writable 1
Total Objects Archived 47 Objects
Total Size of Archived Objects 54 M
Total Objects Purged 37 Objects
Total Size of Purged Objects 474 M
Gateway Nodes
Gateway Modes Installed 2
Gateway Nodes Readable 2
Gateway MNodes Writable 1
Total Cache of Primary Gateway Modes 225G
Total Cached Files of Primary Gateway Nodes 0
Total Files Stored to Grid - Pending 0
Total Filee Storad to Grd _ Atterpntad 2330

I Total Files Stored to Grid - Successful 8,379 I
TS f

Figure 9: Grid Summary Page: Verifying Ingest

NOTE If the integration test is being performed for an existing grid with
client activity on other gateway replication groups, use the value
of “Files Stored to Grid — Successful” for the primary FSG being
tested (on »FSG PStorage »Overview) instead.

Copy the two test files from the StorageGRID Software CD to the
share. Copying the files to the share automatically stores the files
into the StorageGRID system.

* For CIFS, drag the files using Windows Explorer from the CD
to the mapped share.
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For NFS, enter: cp <cd _dev/testdata/>*.jpg <myGrid>
where <myGrid> is the mount point.

*  Verify the files are visible on the primary FSG share. Enter:
1ls <myGrid>/*
5. In the NMS M, verify that these two values increased by 2:
* Total Files Stored to Grid — Successful
* Total Managed Objects

It may take a couple of minutes for the value to change. Stored files
may appear as Total Files Stored to Grid — Pending briefly, before the
store is complete.

6. Verify the files are “mirrored” in each secondary FSG:

+  For CIFS, look at the secondary FSG Explorer window. You
may need to refresh the window by pressing <F5>.

* For NFS, enter: 1s <mySecondary>/Sample*.jpg

where <mySecondary> is the mount point of the secondary FSG.

Test File Retrieval

Verify that the StorageGRID system allows files to be retrieved
through the primary and secondary FSG file shares.

1. Confirm that the test files have been successfully stored to the grid.
See “Test File Ingest” on page 77.

2. Inthe NMS M], go to the Overview Summary page and note the
value of Total Files Retrieved from Grid — Successful.
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= -
Grid Management | Overview \ Alarms Reports Configuration

g Account Management Main Tasks
LTT-;;? FSG Management Total Size of Purged Objects MNAA
El-g HTTP Management
él-g Grid Configuration Gateway Nodes
g ILM Management
4 NMS Management Gateway MNodes Installed 2
Gateway Nodes Readable 1
Gateway Modes Writable 1
Total Cache of Primary Gateway Modes 225G
157 ) Regional Archive Total Cached Files of Primary Gateway Nodes 0
Total Files Stored to Grid - Pending 0
G- 0C Total Files Stored to Grid - Attempted 4
Total Files Stored to Grid - Successful 4
Total Files Stored to Grid - Cancelled 0
Total Files Stored to Grid - Retrying 0
Total Files Stored to Grid - Retries 0
Total Bytes Stored to Grid 14
Total Files Retrieved from Grid - Pending 0
TotalEilssRatrauad fom Cod . Aliampiad 4
I Total Files Retrieved from Grid - Successful 1 I
Otal T es Metneved mom Gig - Retymng U
Total Files Retrieved from Grid - Retries 0
Total Files Retrieved from Grid - Failed 0
Total Bytes Retrieved from Grid 14

Total File Remove Notifications
Total Number of Files

=y

Figure 10: Grid Summary Page: Verifying Retrieval

NOTE If the integration test is being performed for an existing grid with
client activity on other gateway replication groups, use the value
of “Files Retrieved from Grid — Successful” for the primary FSG
being tested (on »FSG »Storage »Overview) instead.

3. Copy the Sample_X-Ray.jpg test file from the primary FSG share to
a temporary location:

*  For CIFS, use Windows Explorer to drag the test file from the
primary FSG share to the desktop.

* For NFS, enter: cp <myGrid>/Sample_X-Ray.jpg <tmp>/
where <myGrid> is the mount point and <tmp> is an available
temporary directory on the client system.

Verify that the files appear in the local temporary file system.
Enter: 1s <tmp>/sample*.jpg

4. Compare the source file on StorageGRID Software CD to the file in
the temporary location to confirm that both copies are identical.
The file retrieved from the grid should be an exact duplicate of the
file that was stored in the first test case.

5. If the replication group includes a secondary FSG, repeat step 3
and step 4 for the Sample-MRl.jpg test file.
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6. In the NMS M], go to the Overview Summary page and confirm that
the value of Total Files Retrieved from Grid — Successful has increased
by 2.

7. Delete the temporary copies from the client’s system:
*  For CIFS, delete the test files from the Windows desktop.

* For NFS, enter:
rm <tmp>/Sample_X-Ray.jpg
rm <tmp>/Sample-MRI.jpg

Test File Deletion

What happens during the file deletion test depends on how content
protection is configured on the grid, that is, whether:

e Deletion is permitted
*  WORM is enabled

* File recovery is enabled

NOTE File recovery is deprecated and no longer supported.

Deletion Is Permitted

Follow this procedure to verify that files can be deleted from a primary
FSG file share when file deletion is permitted, that is, when WORM is
not enabled.

1. Confirm that the test files have been successfully stored to the grid.
See “Test File Ingest” on page 77.

2. Inthe NMS M], go to the grid’s Overview Summary page and note
the value of Total File Remove Notifications.
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= -
Grid Management | Overview \ Alarms Reports Configuration

g Account Management Main Tazks

'—Tj‘g FSG Management Total Size of Purged Objects N/A

I%I— J HTTP Management

El-g Grid Configuration Gateway Nodes
g ILM Management

7 NMS Management Gateway MNodes Installed
= ~
Gateway Nodes Readable
B Grid Topology Gateway Nodes Writable
Total Cache of Primary Gateway Modes
#5F P Regional Archive Total Cached Files of Primary Gateway Nodes

[
o
(0]

Total Files Stored to Grid - Pending

G- 0C Total Files Stored to Grid - Attempted
Total Files Stored to Grid - Successful
Total Files Stored to Grid - Cancelled
Total Files Stored to Grid - Retrying
Total Files Stored to Grid - Retries
Total Bytes Stored to Grid

—ooo kRO o) P

=

Total Files Retrieved from Grid - Pending
Total Files Retrieved from Grid - Attempted
Total Files Retrieved from Grid - Successful
Total Files Retrieved from Grid - Retrying
Total Files Retrieved from Grid - Retries
Total Files Retrieved from Grid - Failed
Total Bytes Retrieved from Grid

A==

=

Total File Remove Notifications
Total umper of Fes

-

Figure 11: Total File Remove Notifications on the Grid Summary

NOTE If the integration test is being performed for an existing grid with
client activity on other gateway replication groups, use the value
of “File Remove Notifications” for the primary FSG being tested
(on »FSG »-Storage »Overview) instead.

3. Delete the test file Sample_X-Ray.jpg from the primary FSG.

*  For CIFS, delete the file from the Windows Explorer share
window.

* For NFS, enter: rm <myGrid>/Sample_X-Ray.3jpg
where <myGrid> is the mount point.

4. Inthe NMS M, verify that the value of Total File Remove Notifica-
tions has increased by 1. It may take a couple of minutes for the
value to change.

5. Verify that the file has disappeared from the FSG share:

*  For CIFS, use Windows Explorer to confirm that the file has
disappeared from the primary FSG and secondary FSG shares.
Press <F5> to refresh the windows as needed.

* For NFS, enter: 1s <myGrid>/Sample*.jpg
The Sample-MRI.jpg test file should not be listed.

Verify the file deleted from the grid has also disappeared from
the secondary FSG shares. Confirm that the listing on the
primary and secondary FSGs is the same.
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The value of File
Remove Notifica-
tions in the NMS Ml
does not change.

The value of File
Remove Natifica-
tions in the NMS M
does not change.
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WORM 1Is Enabled

Follow this procedure to confirm that files cannot be deleted from the
primary FSG when WORM is enabled.

1.

Confirm that the test files have been successfully stored to the grid.
See “Test File Ingest” on page 77.

Go to Grid Management » FSG Management P <Replication
Group> » Overview » Main and confirm that WORM is Enabled and
that the protection period is not set so small as to effectively
disable WORM for that profile.

Delete the test file Sample_X-Ray.jpg from the primary FSG. See
step 3 on page 82.
Confirm that the Permission Denied message appears.

For CIFS, press F5 to refresh the window and confirm the file is
still present in the share. In Windows XP or later, the Denied
message does not appear even though the file is preserved.

File Recovery Is Enabled

Follow this procedure to confirm that files deleted from the FSG are
transferred to the share’s recovery directory when file recovery is

enabled.

1. Confirm that the test files have been successfully stored to the grid.
See “Test File Ingest” on page 77.

2. Go to Grid Management » FSG Management » <Replication
Group> » Configuration » Profiles and confirm that File Recovery is
Enabled for the FSG profile.

3. Delete the test file Sample_X-Ray.jpg from the primary FSG. See
step 3 on page 82.

4. Verify that the file has disappeared from the FSG share. See step 5
on page 82.

5. Verify that the file has been transferred to the recovery directory.

The recovery directory is named <share>-recovery, where <share> is
the name of the parent directory. For example, the recovery direc-
tory of the share fsg/myshare is /fsg/myshare-recovery.

+ If a share was created for the <share>-recovery directory using
either the CIFS or NFS configuration utility, mount the
recovery share and look for the file.

+ If a share was not created for the <share>-recovery directory, log
in to a command shell on the FSG and look for the file under
the /fsg/<share>-recovery directory.
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Test Secondary FSG Read-Only Permissions

This test verifies that the secondary FSG is read-only and does not
permit the writing or deleting of files. An HAGC may not include a
separate secondary FSG. In this case, skip this test.

1. Attempt to delete the file Sample-MRI.jpg from the secondary FSG.
A Permission Denied message should result.

+ For CIFS, use Windows Explorer to delete the file from the sec-
ondary FSG share.

NOTE In Windows XP or later, this action does not result in an Access
Denied message. Press <F5> to refresh Explorer and confirm
that the file is still present.

° ForPJFS,enter:rm <mySecondary>/Sample-MRI.jpg

2. Attempt to copy the file Sample_X-Ray.jpg to the secondary FSG. A
Permission Denied message should result.

*  For CIFS, use Windows Explorer to copy the file to the second-
ary FSG share.

NOTE In Windows XP or later, this action does not result in an Access
Denied message.

* For NFS, enter:
cp <cd _dev/testdata/>Sample_X-Ray.jpg <mySecondary>

Repeat this test for each secondary FSG.

Test High Availability Gateway Clusters

If desired, repeat the tests from the supplementary FSG for the HAGC.

1. Fail over from the main FSG to the supplementary FSG. Follow the
instructions in the Maintenance Guide.

Perform the entire verification test.

3. Fail back from the supplementary FSG to the main FSG, making it
the active primary.
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Conclude the Test

To conclude the test, leave a clean file system for the end user client.

1.

If deletion is permitted, delete the remaining test files from the
primary FSG share:

*  For CIFS, use Windows Explorer to delete the file.

* For NFS, enter: rm <myGrid>/sample*.jpg

If file recovery is enabled, remove the file from the recovery
directory.

If deletion is not permitted (WORM mode is enabled), ask the
customer for their preference. If they prefer that you remove the
test files, temporarily disable WORM mode and remove the test
files:

a. Follow the procedures in the Administrator Guide to disable
WORM mode on the file share.

b. Delete the remaining test file from the primary FSG share.

c. Re-enable WORM mode on the share, as described in the
Administrator Guide.

WARNING Ensure that you re-enable WORM mode. Customer

data is at risk until deletion protection is restored.

4. For CIFS, close all Explorer windows.
5. Log out of the NMS MI and close the browser window.

6. Remove the StorageGRID Software CD from the client computer.

Test the Audit Client

NetApp StorageGRID
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If the Audit option is deployed, you must set up and verify the audit
client.

To perform the verification, create an NFS or CIFS audit fileshare as
described in the Administrator Guide. Have the customer system
administrator perform these tests with your guidance, using a client.

Perform the test for each grid node (Admin Node or Audit Node) that

hosts an AMS service.

85



Installation Guide

CIFS Integration

The connection setup of the audit client is the same as for FSG shares,
substituting the IP address of the Admin Node or Audit Node and
using audit-export as <Share_Name>.

The audit share is read-only. Log files are intended to be read by
computer applications; verification does not include opening a file. It
is considered sufficient verification that the audit log file(s) appear in a
Windows Explorer window. Following connection verification, close
all windows.

NFS Integration

Mount and Verify Audit Client Share

1.
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Verify connectivity. Enter: ping <IP_address>

(or variant for the client system) using the client-side IP address of
the grid node (Admin Node or Audit Node) hosting the AMS
service. Verify that the server responds, indicating connectivity.

Mount the audit read-only share using a command appropriate to
the client OS. A sample Linux command is (enter on one line):
mount -t nfs -o hard,intr <Admin_Node_IP_address>:/var/
local/audit/export <myAudit>

Use the IP address of the grid node (Admin Node or Audit Node)
hosting the AMS service and the predefined share name for the
audit system. The mount point can be any name selected by the
client (for example, myAudit in the command above).

Verity the files are available from the audit share. Enter:

1ls <myAudit>/*

where <myAudit> is the mount point of the audit share. There
should be at least one log file listed.
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Grid Specification Files
and Provisioning

What is Provisioning

Provisioning is the process of turning a grid design into the collection of
tiles needed to create, expand, maintain, or upgrade the grid. That collec-
tion of files, referred to as the GPT (grid provisioning tool) repository,
includes the SAID package. The key input for provisioning is the grid
specification file.

About the SAID Package

NetApp StorageGRID
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The Software Activation and Integration Data (SAID) package contains
site-specific files for the grid. It is generated during the provisioning
process as a zip file and is named using the following naming
convention:

GID<grid_ID>_REV<revision_number>_SAID.zip

The SAID package contains the following items:

Table 9:
Item Description
Doc directory Contains html files used to confirm provisioning.
Escrow_Keys Encryption keys used by the Data Recovery Tool.
directory
Grid_Activation Contains activation files, one for each server. Acti-
directory vation files are named <servername>-autoinst.xml.

Activation files are keyed to work with the
hardware used for the grid deployment and the
version of StorageGRID software.
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Table 9:

Item

Description

Configuration.txt

Lists grid-wide configuration and integration data
generated during the provisioning process.

Grid_Tasks directory

Contains files created by some types of changes to
the grid specification file, such as adding a server
or converting the grid to use metadata replication.
Grid tasks are used to trigger various actions
within the grid that are required to implement the
specified changes to the grid.

Grid specification file

XML file that encapsulates the grid design. File
name is:

GID<grid_ID>_REV<revision_number>_GSPEC.xml

Passwords.txt

Passwords used to access the grid.

Grid Configuration Files

The index.html can
only be opened in a
Windows Internet
Explorer browser.
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The Doc directory of the SAID package contains html files document-
ing the specifications of the grid’s configuration. Use these pages to
confirm that the grid configuration is correct and complete.

e Click the <SAID_package>/doc/index.html file. For an example, see

Figure 12 below.

Grid Services | Network Groups Storage NTP Archives
Prirt Page
Grid Wide Settings
Grid ID: B00101
Grid Description Regional Archive
Software Suite Version: 9041
Senvice Pack Required: none
ILM Rules: libcfg-replication.so
Metadata Replication: disabled
Grid Options:
DICOM: enabled
Servers Summary
Hosthame Grid IP SSH Access Services Node ID Hardware Spec
{/Regional Archive/DC/
S8M 16638534
ths-de-cnl 172.31.26.103 il ChWS 13520866 ibrn-x346
ADC 11736949
S8M 16604789
ths-de-rg1-gnl 172.31.26.101 CLE 17607874 ibrn-x346
FSG 20922709
S8M 16522424
ths-de-rgl-gn2 172.31.26.102 CLE 17849408 ibrn-x346
FSG 20311234
S8M 16911759
ths-di-sn1 172.31.26.105 LOR 12563252 ibm-1336-starage
{/Regional Archive/DR/
S8M 16084186
s MMWS 14781903
the-dr-ani 172.31.26.200 AMS 15337528 ibrm-x336
CHhN 18647395

Figure 12: Index.html File
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About Grid Specification Files

The grid specification file is an XML file that encapsulates the configu-
ration information needed to install, expand, and maintain a grid. The
file includes topology, servers, options, and networking details for the
grid.

Tree View | XSL Output
& ol wversion="1.0" encoding="utf-5§"
=3 gptConsolidated
w3 gridbesigner
w3 gridbeployment
w3 hardwareProfiles
= gptEpec
mE3 grid

& xmlns:xsi http://www. w3 . org/ 2001/ KMLSchema-instance
& xzi:schemalocation http://www. bycast.com/GPT/schemas grid 1.4.xsd
& xmlns http://waw. bycast.com/GPT/grid

#- @ schema-version 2.2

#- @ software-version 8.1.3

- & hrand BYC

WM gid 12345

w @ license gid=12345

# @ description Regional Archive

#--IC) passwords

# I cms-settings

#-IZ) mms-settings

#-13) ntp

) site

& neme Regional Archive

B--E3 site

& name Data Center

#-IZ) control-storage

#-IZ) control-storage
#--I) admin

il ool

Figure 13: Grid Specification File in XML Notepad 2007

All new grid specification files are created and deployed using Grid
Designer. As well, all grid specification files updated to
StorageGRID 9.0 are edited and deployed using Grid Designer. For
more information, see the Grid Designer User Guide.

Grid Specification File Stages

NetApp StorageGRID
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The grid specification file goes through a number of stages as the grid

is designed and then installed:

* Default grid specification file — The default grid specification file
describes the basic grid topology and grid configuration.

e Deployment grid specification file — The deployment grid specifi-
cation file is created from the default grid specification file by
updating the grid specification file with customer-specific data, for
example IP addresses

e Provisioned grid specification file — The provisioned grid specifi-
cation file is created when the provision command is run.

These stages are summarized in Figure 14 below.
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Design New Grid

Request for new grid

Prepare default grid
specification file

I

Default grid
specification file

Replace factory
defaults in default grid
specification file with

customer-specific
information

Deployment grid
specification file

‘ Provision grid ‘

I

Provisioned grid
specification file

Modify Grid

Request for grid
changes
Export provisioned

grid specification file
from the grid

v

Provisioned grid
specification file

Edit grid specification
file

A
Deployment grid
specification file

‘ Provision grid ‘

!

Provisioned grid
specification file

Figure 14: Editing the Grid Specification File

Naming Convention

90

Grid specification files use the naming convention
GID<grid_ID>_REV<revision_number>_GSPEC.xml, where <grid_ID>
refers to the grid’s unique identifier and <revision_number> refers to the
revision number of the grid specification file, for example,
GID1234_REV1_GSPEC.xml.

The default grid specification file has a <revision_number> of zero
(REVO). The revision number is increased by 1 each time the grid spec-
ification file is modified, for example to add servers, change IP
addresses, or refresh hardware. For the initial installation of the grid,
the revision number must be 1 (REV1) — that is, the default grid speci-
fication file has been modified once for the installation of the
StorageGRID system. Any other revision number will cause provision-
ing to fail.
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Grid Specification File Structure

Grid specification files are edited and deployed using Grid Designer.
The following section describes the xml structure of the grid specifica-
tion file.

Server Names

To review grid information using the grid specification file, you must
ensure that you select the correct server. Table 10 below lists the server
tags. In addition, check the server name
(gptSpec>grid>site>site>server>name) to confirm that you are using the
correct server.

Table 10: Server Tags

Server XML Tag
Admin Node admin
API Gateway Node gateway
Archive Node archive
Audit Node custom
Control Node control
Gateway Node gateway
Storage Node storage
NetApp StorageGRID 91
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Tags

Table 11 below lists the XML tags of the attributes most likely to be
reviewed or updated.

Table 11: Common Changes to Grid Specification Files

Setting

XML Tag

Notes

External NTP time sources

- gptipec

=) grid
& xmlns:xsi
& x=si:schemalocation
& xmlns
& schema-—version
& software-version
£ brand
& gid
£ licensze
[ description
) passwords
L cms—sSettings
) nms—settings
) ntp
S =0 e S

+ ip
ip
ip
ip

TN R e e e R e e e

ececee

¥
¥
¥

gptSpec>grid>ntp>sources>ip

To provide a stable time
source, it is recommended
that four NTP time servers be
used.

External time sources must
use the NTP protocol and not
the SNTP protocol. In particu-
lar, do not use the Windows
Time Service: it does not
provide enough synchroniza-
tion accuracy because it uses
SNTP.

Networking information in a
grid that does not have a private
network

S W= i n—gateway
& name
& nms-nsme
+ @ group
+ ‘v ntp-role
[ ssh-access-point
+ £ nw
+ [ default-gatevay
=) grid-network
+--I) bonded
+ £ ip
+ £ maszk
& routes
+--|) services-config

gptSpec>grid>site>site>
server>default-gateway

gptSpec>grid>site>site>
server>grid-network>ip

gptSpec>grid>site>site>
server>grid-network>mask

gptSpec>grid>site>site>
server>grid-network>routes

NMS Entity Name

gptSpec>grid>site>site>
nms-name

Adds the attribute nms-
name=“<name>" to the
element tags for grid, site, and
server. For example:

<site name=“grid name”
nms-name= “grid one”>
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Table 11: Common Changes to Grid Specification Files (cont.)

Setting XML Tag Notes

Networking information for grid  gptSpec>grid>site>site>
communication in grid with a server>default-gateway
private network

gptSpec>grid>site>site>
= ) admin-gatews . .
e nae server>grid-network>ip
& nms-name
+- M group . . .
- © ntperole gptSpec>gr|d>S|te>S|te>
t ssh-access-point server>grid-network>mask
+ hr
ot gptSpec>grid>site>site>
* E' bonded server>grid-network>routes
+ ip
+] £ maszk
=) routes
=) route
- net
+] £ maszk
- M g
Networking information for gptSpec>grid>site>site> Servers that have client-side
client access in a grid with a server>default-gateway IP addresses are
private network — - Admin Nodes,
o i geseray gptSpec>gr|d>Slt.e>Slte> Gateway Nodes, and
O e server>network>ip Archive Nodes.
4l group m
G e e potn: gptSpec>grid>site>site>
L © teeauic-qareras server>network>mask
] ) grid-network
7 G bonaea gptSpec>grid>site>site>
T8 e server>network>routes
Virtual IP address of gptSpec>grid>site>site> Virtual IP addresses are used
Gateway Node cluster gateway>services-config> with high availability clusters.
: fsg>main-in-cluster>virtual-ip
) gateway
&' name
&' nms—-name
& group
‘v ntp-role
£ nw

[ default-gatevay
) grid-network
) network
) services-config
+--| ) s=m
© cib
=G £8g
+ [ fag-group
[ primary
= (mWain-in-cluster
+ £ hearthest-interface
+ £ customer-interface
+ [ wirtual-ip
+ [ ping-node

1] [ F- - - -
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Table 11: Common Changes to Grid Specification Files (cont.)

Setting XML Tag Notes
Heartbeat IP addresses gptSpec>grid>site>site> Heartbeat IP addresses are
5 £ gateway gateway>network>ip only used with High Avail-
t name ability Gateway Clusters.
z t group They do not need to be
+ ntp-role e .
0 hu modified unless they conflict
@ detoult-gateway with another network. If nec-
=2 network essary, substitute the 10.1.1.x
+- Ml device .
s network with another unused
- mask non-routeable network.

b routes

View a Copy of the Grid Specification File

Follow this procedure if you need to quickly check the grid specifica-
tion file. If you need to edit the file, use the procedure in “Export the
Latest Grid Specification File” on page 95 to obtain a copy of the file.

1. In the NMS M]I, go to Grid Management » Grid Configuration »
Configuration » Main.

Overview Configuration |

Main

w= =l Configuration: Grid Configuration

1= Updsted: 2011-11-04 12:20:30 FOT

Grid Options ;f
Grid Language [United States - English =
Stored Object Compression [ Disabled =l
Stored Object Encryption |AES-255 d
Stored Object Hashing [sHA-256 =l
Deduplication Disabled
Disable Client Delete [Disabled =l
Security Partitions [Disabled =
Configurable ILM Enabled Vlew Grld
Metadata Replication Enabled SpeCIfIca-
Large Object Optimizations | Enabled = tion File
Netwark Transfer Encryption |AE5255-SHA =
Grid Specification File 8
Click the export button to view the Grid Specification File.
Apply Changes u

Figure 15: View the Grid Specification File

2. Click Export i at the bottom of the page, next to Grid Specification
File. A new browser window opens, showing the grid specification
file in raw XML.
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215-06991_CO0



Grid Specification Files and Provisioning

Export the Latest Grid Specification File
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Admin Node Hosted on a Virtual Machine

Prerequisites and Required Materials

Passwords.txt file

a utility such as Winlmage (available at http://www.winim-
age.com), that permits you to create a floppy disk image

a tool such as WinSCP (available at http://winscp.net/eng/down-
load.php) to transfer files to and from the Admin Node

Service laptop

Procedure

1.

5.

At the primary Admin Node server, access a command shell and
log in as root using the password listed in the Passwords.txt file.

Create a directory to hold the provisioned grid specification file.
Enter: mkdir -p /root/usb

Copy the provisioned grid specification file to the directory. Enter:

copy-grid-spec /root/usb

Use WiIinSCP to copy the GID<Grid_ID>_REV<revision_number>_
GSPEC.xml file from the Admin Node to your service laptop.

Alternatively, copy the file from the Admin Node to your service
laptop using a floppy image. Create the floppy image on your
service laptop, connect to it in the vSphere client, and then mount
it under Linux as /media/floppy. Copy the grid specification file to
the floppy image from the Admin Node virtual machine, unmount
it, and then extract the files to your laptop.

Log out. Enter: exit

Admin Node Hosted on a Physical Server

NOTE New installations of the StorageGRID 9.0 system are not supported

on physical servers. Virtual machines must be used.

Prerequisites and Required Materials

USB flash drive

Passwords.txt file
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Procedure

1.

At the primary Admin Node server, access a command shell and
log in as root using the password listed in the Passwords.txt file.

2. Insert a USB flash drive.
3. Copy the provisioned grid specification file to the USB flash drive.

Enter: copy-grid-spec

Log out. Enter: exit

Provision the Grid

Use this procedure to implement the changes made to the grid specifi-
cation file. The provisioning script imports the updated grid
specification file into the grid and generates any grid tasks required to
complete the implementation of the changes.

On a Primary Admin Node on a Virtual Machine

Prerequisites and Required Materials

Deployment grid specification file. See “Export the Latest Grid
Specification File” on page 95.

A utility such as Winlmage (available at http://www.winim-
age.com), that permits you to create a floppy disk image
Passwords.txt file

Provisioning passphrase

A tool such as WinSCP (available at http://winscp.net/eng/down-
load.php) to transfer files to and from the Admin Node

Service laptop

Procedure

1.
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Create a floppy image that contains the deployment grid specifica-
tion file:

a. Start the Winlmage software on your service laptop.

b. From the File menu, select New. In the Format selection dialog,
select a standard format 1.44 MB floppy. Click OK.

NetApp StorageGRID
215-06991_CO0


http://www.winimage.com
http://www.winimage.com
http://winscp.net/eng/download.php
http://winscp.net/eng/download.php

Grid Specification Files and Provisioning

NetApp StorageGRID
215-06991_CO0

c. From the Image menu, select Inject. Browse for the grid specifi-
cation file, and select Open. When prompted, confirm that you
want to inject the file. Select Yes.

Save the floppy image:

a. From the File menu, select Save.

b. In the Save dialog, browse to the destination folder.

c. Select Save as type: Virtual floppy Image (*.vfd,*.flp)

d. Enter a filename ending in .flp. For example, <servername>. f1p

You must enter the extension, or the vSphere client cannot use
the image during installation.

e. Click Save.

At the primary Admin Node, log in as root. When prompted for a
password, press <Enter>.

In vSphere Client, connect the Provisioning floppy image by
clicking the Connect/Disconnect the floppy devices of the virtual
machine icon and selecting Connect Floppy 1 » Connect to floppy
image on local disk.

Click in the vSphere console window to return to the command
line.

Copy the GID<Grid_ID>_REV<revision_number>_GSPEC.xml file from
the deployment floppy image to the primary Admin Node:

a. Mount the floppy image. Enter: mount /media/floppy

b. Copy its contents to the Admin Node. Enter:

mkdir /root/usb
cp /media/floppy/* /root/usb

c. Unmount the floppy image. It is no longer needed. Enter:
umount /media/floppy
Remove any old grid specification files from /root/usb.

Ensure that there is only one file named
GID<grid_ID>_REV<revision_number>_GSPEC.xml.

NOTE The /root/usb directory must contain only one grid specification
file. Otherwise, provisioning will fail.

Run the provisioning script:

a. At the primary Admin Node server, access a command shell
and log in as root using the password listed in the Passwords.txt
tile.

b. Run the provisioning script. Enter: provision /root/usb
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10.

c. When prompted, enter the provisioning passphrase.

When the process is complete, “Provisioning complete” is displayed.

NOTE If provisioning ends with an error message, see “Provisioning
Troubleshooting” on page 105.

Back up the provisioning data to another directory on the
Admin Node.

a. Create a directory for the backup provisioning data. Enter:
mkdir -p /var/local/backup

b. Back up the provisioning data. Enter:
backup-to-usb-key /var/local/backup
c. When prompted, enter the provisioning passphrase.

Store the Provisioning directory (found at /root/usb) and the
Backup Provisioning directory (found at /var/local/backup) sepa-
rately in a safe place. For example, use WinSCP to copy these
directories to your service laptop, and then store them to two
separate USB flash drives that are stored in two separate and
secure locations. For more information, see “Preserving Copies of
the Provisioning Data” on page 104.

The contents of the Provisioning directory are used during expan-
sion and maintenance of the grid when a new SAID package must
be generated.

WARNING Store copies of the Provisioning directory in two

separate and secure locations. The Provisioning direc-
tories contain encryption keys and passwords that can
be used to obtain data from the grid. The Provisioning
directory is also required to recover from a primary
Admin Node failure.

On a Primary Admin Node on a Physical Server
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NOTE New installations of the StorageGRID 9.0 system are not supported

on physical servers. Virtual machines must be used.

Prerequisites and Required Materials

Deployment grid specification file. See “Export the Latest Grid
Specification File” on page 95.
Provisioning USB flash drive
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The Provisioning
USB flash drive
must contain only
one grid specifica-
tion file at the root
level. Otherwise,
provisioning will fail.
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Backup Provisioning USB flash drive
Passwords.txt file

Provisioning passphrase

Procedure

1. Copy the edited grid specification file to the root level of the Provi-
sioning USB flash drive.

2. Remove the old grid specification file from the root level of the Pro-
visioning USB flash drive.

3. Verify that the Provisioning USB flash drive contains only one grid
specification file at the root level, that is, there is only one file named
GID<grid_ID>_REV<revision_number>_GSPEC.xml.

4. Run the provisioning script:

a. Atthe primary Admin Node server, access a command shell and
log in as root using the password listed in the Passwords.txt file.
b. Run the provisioning script. Enter: provision
c. When prompted, insert the Provisioning USB flash drive.
d. When prompted, enter the provisioning passphrase.
e. When provisioning is complete, remove the Provisioning USB
flash drive.
NOTE If provisioning ends with an error message, see “Provisioning Trou-
bleshooting” on page 105.
5. Back up the provisioning data:
a. Insert the Backup Provisioning USB flash drive.
b. Enter: backup-to-usb-key
c. When prompted, enter the provisioning passphrase.

6. When backup is complete, remove the Backup Provisioning USB
flash drive.

7. Review the current configuration to confirm all settings are correct:

a. Copy the file GID<grid_ID>_REV<revision_number>_SAID.zip on
the USB Provisioning flash drive to the service laptop and
extract the contents.

b. Inspect the file Doc\Index.html to make sure that the settings are
correct. If there is an error, you need to provision the grid again.
For more information, see “Errors in Grid Specification File” on
page 106.
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8. Store the Provisioning USB flash drive and the Backup Provision-
ing USB flash drive separately in safe locations.

WARNING Store copies of the Provisioning USB flash drive and
the Backup Provisioning USB flash drive in two
separate and secure locations. The USB flash drives
contain encryption keys and passwords that can be
used to obtain data from the grid. The Provisioning
USB flash drive is also required to recover from a
primary Admin Node failure.

Change the Provisioning Passphrase

Use this procedure to update the provisioning passphrase. The provi-
sioning passphrase is used to encrypt the GPT repository. It is created
when the grid is first installed and is required for software upgrades,
grid expansions, and many maintenance procedures.

WARNING The provisioning passphrase is required for many
installation and maintenance procedures. The provi-
sioning passphrase is not listed in the Passwords.txt
file. Make sure that it is documented and kept in a safe
location.

On a Primary Admin Node on a Virtual Machine

Prerequisites and Required Materials
* Passwords.txt file
e Current provisioning passphrase

* New provisioning passphrase

Procedure

1. At the primary Admin Node server, access a command shell and
log in as root using the password listed in the Passwords.txt file.
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2. Change the passphrase:
a. Enter: change-repository-passphrase <path>

where <path> is the location on the server where you want to
store a copy of the updated GPT repository.

b. When prompted, enter the old passphrase.

When prompted, enter the new passphrase. It must be at least six
characters.

d. When prompted, enter the passphrase again.

The passphrase of the GPT repository is changed to the new
value, and an updated copy of the repository that uses this
password is saved to <path>.

WARNING The provisioning passphrase is required for many
installation and maintenance procedures. The provi-
sioning passphrase is not listed in the Passwords.txt
file. Make sure that it is documented and kept in a safe
location.

3. Back up the provisioning data to another directory on the
Admin Node. This backup copy can be used to restore the grid in the
case of an emergency or during an upgrade or grid expansion.

a. Create a directory for the backup provisioning data. Enter:
mkdir -p /var/local/backup
b. Back up the provisioning data. Enter:
backup-to-usb-key /var/local/backup
c. When prompted, enter the provisioning passphrase.
4. Store the contents of the Provisioning directory (found at </var/local/
gpt-data/>) and the Backup Provisioning directories (/var/local/backup)

separately in a safe place. For more information, see “Preserving
Copies of the Provisioning Data” on page 104.

WARNING Protect the contents of the Provisioning directory. The
Provisioning directory contains encryption keys and
passwords that can be used to obtain data from the grid.
The Provisioning directory is also required to recover
from a primary Admin Node failure.

5. C(Close the command shell. Enter: exit

6. Write down the provisioning passphrase for future reference.
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On a Primary Admin Node on a Physical Server

NOTE New installations of the StorageGRID 9.0 system are not supported

on physical servers. Virtual machines must be used.

Prerequisites and Required Materials

Provisioning USB flash drive

Backup Provisioning USB flash drive

Passwords.txt file

Current provisioning passphrase

New provisioning passphrase

Procedure

1.

At the primary Admin Node server, access a command shell and
log in as root using the password listed in the Passwords.txt file.

Change the passphrase:

a.
b.

C.

d.
e.

Enter: change-repository-password
When prompted, enter the old passphrase.

When prompted, enter the new passphrase. It must be at least
six characters.

When prompted, enter the passphrase again.
When prompted, insert the Provisioning USB flash drive.

Remove the Provisioning USB flash drive and store in a safe
place.

When prompted, insert the Backup Provisioning USB flash drive.

When backup is complete, remove the Backup Provisioning USB
flash drive and store it in a safe place.

WARNING Store copies of the Provisioning USB flash drive and

the Backup Provisioning USB flash drive in two
separate and secure locations. The USB flash drives
contain encryption keys and passwords that can be
used to obtain data from the grid. The Provisioning
USB flash drive is also required to recover from a
primary Admin Node failure.

6. Close the command shell. Enter: exit
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7. Write down the provisioning passphrase for future reference.

WARNING The provisioning passphrase is required for many
installation and maintenance procedures. The provi-
sioning passphrase is not listed in the Passwords.txt
file. Make sure that it is documented and kept in a safe
location.

Provisioning without a USB Flash Drive

NetApp StorageGRID
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The following commands are run at the command shell interface of the
primary Admin Node to either update or copy grid provisioning data:
*  provision

e change-repository-passphrase

e copy-grid-spec

*  backup-to-usb-key

e restore-from-usb-key

* load-provisioning-software

By default, provisioning data is assumed to be stored on the Provision-
ing USB flash drive and the Backup USB flash drive. You are prompted
to insert the appropriate device so that updated data can be written to
these locations.

However, you can store provisioning information to another location
by optionally entering a file path as an argument to each of these com-
mands, as follows:

*  provision <path>

* change-repository-passphrase <path>

*  copy-grid-spec <path>

e backup-to-usb-key <path>

* restore-from-usb-key <path>

When loading provisioning software during upgrade, use the follow-
ing flag to specify an alternate location for the updated provisioning
information:

* load-provisioning-software --alternate-usb-dir=<path>

If you choose to store provisioning data to another location, be aware
of the following:
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For information on
supported versions
of VMware soft-
ware, see the
Interoperability
Matrix Tool (IMT)

* the size of the GPT repository increases every time the provision
command is run because a new revision is created and is added to
the GPT repository

* preserving copies of the GPT repository is critical to the continued
operation of the grid, as described in “Preserving Copies of the
Provisioning Data” below.

Because VMware vSphere software does not support the use of USB
flash drives, it is required that you store provisioning data to an alter-
nate location when the primary Admin Node is installed in a virtual
machine. Floppy disk images are sometimes used to transfer data to or
from software running in a virtual machine, but you should be aware
of the following:

e except for very small grids, the SAID package is too large to place
on a floppy disk image

¢ except for very small grids that have only a few revisions, the GPT
repository is too large to place on a floppy disk image

Therefore you will generally store provisioning data to a location on
the primary Admin Node, and immediately make additional copies in
alternate locations as described in “Preserving Copies of the Provision-
ing Data” below.

Preserving Copies of the Provisioning Data

104

Preserving the grid’s GPT repository is critical to the continued opera-
tion of StorageGRID software. The contents of the GPT repository are
required to upgrade, maintain, or expand the grid. The GPT repository
is also required to restore the primary Admin Node, should it fail and
require replacement.

VMware vSphere does not permit you to store data from the grid node
directly to a USB flash drive. Each time you run one of the commands
that update or copy grid provisioning data, you must back up the pro-
visioning data to two secure locations, preferably in two distinct
physical locations. For example, use a tool such as WinSCP to copy the
provisioning data to your service laptop, and then store it to two USB
flash drives. Store these USB flash drives separately in two geographi-
cally distinct secure locations such as a locked cabinet or safe. The USB
flash drives contain encryption keys and passwords that can be used
to obtain data from the grid.

NetApp StorageGRID
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WARNING Always store two copies of the GPT repository in two
separate and secure locations. The GPT repository is
essential to the continued operation of the grid, and to
recover from a failed primary Admin Node.

It is possible to back up provisioning data directly into the grid by
saving a copy to an FSG file share. If you store a copy to the grid, it is
recommended that you always store a second copy in another location
outside of the grid. The SAID package includes a two-part encryption
key that permits you to recover data from grid nodes in the event of a
catastrophic grid failure. If the only copies of these keys are in the grid
itself, it is not possible to recover data after such a failure.

In a grid where the primary Admin Node was upgraded to Storage-
GRID 9.0 and is installed directly on a physical server, it is
recommended that you store provisioning data on two USB flash
drives (the Provisioning USB flash drive and the Backup USB flash
drive). Store the Provisioning USB flash drive and the Backup Provi-
sioning USB flash drive separately in two geographically distinct
secure locations such as a locked cabinet or safe. The USB flash drives
contain encryption keys and passwords that can be used to obtain data
from the grid.

NOTE New installations of the StorageGRID 9.0 system are not supported
on physical servers. Virtual machines must be used.

Provisioning Troubleshooting

In case of provisioning errors, follow the guidelines below.
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Provision command
fails

Provision command
completes normally,
but there are
configuration errors
in the SAID package

Look for log file on
provisioning media

Get revision number

from grid spec
file

provision-fail.log is
the only file

Provision-crash-
<grid_info>.log
created

provision command again. There is

Fix the grid specification file (keep
same rev number). Run the

no need to run the command
remove-provision.

Rev number of
grid spec file is 1
(new installation

A,

Contact Support and supply the log

files found on provisioning media.

Al other revisions

number at 1). Start installation over,
i.e reinstall Linux, load provisioning

Fix grid specification file (keep rev

software, run provisioning
command.

Run remove-provision, fix grid spec

file (keep same rev number), run
provision command again.

Figure 16: Troubleshooting Provisioning Errors

Provision Command Fails

If provisioning fails because the grid specification file is incorrect, the
tile provision-fail.log is created on the Provisioning Media. This file
contains the error message that the provisioning software displayed

before terminating.

If the provisioning program terminates abnormally (crash), two identi-
cal log files are saved to the Provisioning Media:

e provision-fail.log

e provision-crash-<grid_info>.log

where <grid_info> includes the grid ID, the grid revision being

created and a ti

mestamp.

If the provision-fail.log file is the only file created, fix the grid specifica-
tion file by updating it with Grid Designer and run provisioning again.
If the provision-crash-<grid_info>.log file is created, contact Support.

If provisioning ends with an error, no information is saved and the
remove-revision command does not need to be run.

Errors in Grid Specification File

106

If the provision command completes normally, but you discover an
error in the provisioning data after examining the configuration pages
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in the SAID package, fix the grid specification file by updating it with
Grid Designer and then reprovision the grid.

Initial Installation

NOTE Follow this procedure if the revision number of the grid specification
file is 1.

If during the initial installation you discover errors in the SAID
package, you must fix the grid specification file and reinstall the
primary Admin Node from the beginning, that is, you must reinstall
Linux, load provisioning software, and provision the grid.

Upgrades, Expansion, and Maintenance
Procedures

NOTE Follow this procedure if the revision number of the grid specification
file is greater than 1. This procedure cannot be used for a new
installation.

1. Confirm that no scripts or grid tasks generated by provisioning
have been started.

2. Remove the provisioning data from the grid. Enter:
remove-revision
The remove-revision command does not remove grid tasks gener-

ated by provisioning nor does it roll back grid tasks that have
already been run.

WARNING Do not use the remove-revision command if you have
started any scripts or grid tasks that were generated
by provisioning. Contact Support for assistance.

3. When prompted, enter the provisioning passphrase.
Cancel any pending grid tasks created by the provisioning.

5. Fix the deployment grid specification file with Grid Designer and
save it to the root directory of the Provisioning Media. Do not
change the REV<revision_number>.

NOTE The Provisioning Media must contain only one grid specification
file at the root level. Otherwise, provisioning will fail.
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6. Run provisioning again and generate a new SAID package. For
more information, see “Provision the Grid” on page 96. The old
SAID package is overwritten and a new one is generated that uses
the same naming convention.

7. Review the contents of the SAID package to confirm that the provi-
sioning information is correct.
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How to Use GDU

Start GDU

NOTE GDU is always run from the primary Admin Node or the HCAC'’s
primary reporting Admin Node.

1. At the primary Admin Node server or the HCAC’s primary report-
ing Admin Node, access a command shell.

If using GDU remotely:
a. Start a Telnet/ssh client such as PuTTY.
b. Select Window » Translation » Remote character set » UTF-8.

22 PuTTY Configuration x|
Category:

[ Session | Options controling character set translation |
I_;| T. I..og‘glng ~ Character set translation
errnKE:board Bemote character set:

el =l
Features (Codepages supported by Windows but not listed here,
= Window such as CP866 on many systems, can be entered
A manually)

pearance

Behaviour

e [~ Treat CJK ambiguous characters as wide

Selection I™ Capg Lock acts as Cyrlic switch
Cclc!.lrs r~ Adjust how PuTTY handles line drawing characters ——
- Connection

Data Handling of line drawing characters:

P ' Use Unicode line drawing code pairts

Tmlw " Poorman's line drawing (+, -and [)

< n‘_ﬁ " Font has XWindows encoding
Rlogin " IUse fort in both ANSI and OEM modes
[H-SSH = |Use font in OEM mode only
Serial [~ Copy and paste line drawing characters as lqgak
About Open Cancel |

Figure 17: PuTTY Settings for GDU
2. Log in as root using the password listed in the Passwords.txt file.

3. If you are using GDU for an upgrade, enter: exec bash
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4. Enter: ssh-add

You need to run ssh-add, which adds the ssh private key to the ssh
agent, each time you start a new shell session.

For more information on ssh access points, see the Administrator
Guide.

If prompted, enter the SSH Access Password listed in the Pass-
words.txt file.

If using PuTTY, start screen. For example, enter: screen -s Gpu

NOTE Do not use screen if running GDU locally because the GDU
console characters will not display properly.

The name of the session (for example GDU in the command above)
is optional, but recommended since it is useful for managing
screen sessions.

The screen program allows you to manage multiple shell instances
concurrently, connect to the same session from different locations,
detach from a session without stopping the program running
within the session, and resume a session that was previously
detached.

To detach from a screen, press <CtrI>+<A> and then <Ctrl>+<D>.
To reattach to a screen, enter: screen -r

Start GDU. Enter: gdu-console

NOTE If you get an error using GDU during an upgrade, it is likely
because the session was already open. Either log out of the
session and log back in, or enter: exec bash

When prompted, enter the provisioning passphrase. Type the pass-
phrase, press <Tab> to select OK, and then press <Enter>.

Figure 18: Entering the Provisioning Passphrase to Start GDU

If the characters do not display properly, see “GDU Display Prob-
lems” on page 115.
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GDU User Interface
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Figure 19: GDU Console

The GDU console consists of five panels:

Servers — Displays the servers in the grid.

Tasks — Displays the procedures that can be performed on the
server selected in the Servers panel. Only the tasks applicable to the
current situation are displayed. It is possible to run GDU tasks in
parallel on different servers.

The list of tasks includes:

Task

Select To

Continue Install

Continue the software installation on the primary
Admin Node or the HCAC’s primary reporting
Admin Node server if it has rebooted.

Enable Services

Start the grid software.

Install Driver

Install a driver from the Enablement Layer for
StorageGRID Software CD.

Install Software

Install the grid software on a new server.

Load Configuration

Load NMS configuration settings.

Reboot Server

Reboot the server and start the services.

Remount Storage

Check for preserved storage volumes and
remount them. Used for maintenance procedures
on Storage Nodes.
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Task

Select To

Start Services

Start Server Manager and all services. This is
equivalent to the command
/etc/init.d/servermanager start

Stop Services

Stop Server Manager and all services. This is
equivalent to the command
/etc/init.d/servermanager stop

Update Software

Apply a service pack.

Upgrade Software

Install a new base version of the software and
apply a service pack.

Update Status

Display the current server status.

These tasks are described in detail in the procedures where they

are used.

Server Info — Displays the state of the server selected in the
Servers panel. The status can be one of:

Current State

Notes

Available The server is available for the tasks listed in the
Tasks panel.

Busy A GDU task is running on this server.

Error A GDU task has failed.

Pingable The server is pingable, but cannot be reached
because there is a problem with the hostname.

Reachable The server can be reached but is not available

because the ssh host keys do not match.

Log Messages — Displays the output of the GDU task executed
for the server selected in the Servers panel. If you are running
multiple GDU tasks in parallel, you can display the output of each
task by selecting the appropriate server in the Servers panel.

Actions — The actions are:

Action Select to

Start Task Start the procedure selected in the Tasks panel.

ISO List List the ISO images that are in the /var/local/
install directory of the primary Admin Node.

Quit Quit GDU.

NetApp StorageGRID
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Entering Commands in GDU

Use the keyboard to enter commands:

To Do

Go from panel to panel Press <Tab>.

Go back from panel to Press <Shift> <Tab>.
panel

Goup and down withina  Press <Up Arrow> and <Down Arrow>

panel Press <Page Up> and <Page Down>

Press <Home> and <End>

Goright and left withina  Press <Left Arrow> and <Right Arrow>.
panel

Select a task Press the space bar. X appears next to the
selected task.
Activate a command Press <Enter>.

Install Drivers with GDU

NetApp StorageGRID
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You can use GDU to install drivers that are included on the Enable-
ment Layer for StorageGRID Software CD in the drivers directory. It is
your responsibility to confirm that the drivers included on the Enable-
ment Layer for StorageGRID Software CD are the most recent
qualified version. If they are not, get the latest version from the
hardware vendor and install the drivers manually.

Prerequisites
¢ Connectivity to the primary Admin Node
e List of drivers required for this server

e Provisioning passphrase

Procedure

1. Start GDU.

2. Select the server in the Servers panel and confirm that its state is
Available.
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Close GDU

3. Install the driver:

a. Select Install Driver in the Tasks panel. A panel listing the avail-
able drivers opens automatically. If the driver you need is not
listed, you must install this driver manually.

Figure 20: Installing Drivers with GDU
b. Select a driver from the list.

c. Select OK. Wait for the driver installation script to complete.

d. Reboot the server: Select Reboot Server in the Tasks panel, then
select Start Task in the Actions panel and press <Enter>.

4. Repeat step 3 if you need to install any other driver on this server
using GDU.

5. If you have finished using GDU, close it and remove passwordless
access.

114

If you quit GDU while a task is in progress, GDU pauses until the task
completes, and then closes. Some tasks, such as formatting storage
volumes on a new Storage Node, can take hours to complete. Avoid
quitting GDU while long-running tasks are in progress. Continue
working in another terminal window.

1. Quit GDU. Select Quit in the Actions panel and then press <Enter>.
When prompted, confirm that you want to quit GDU.

2. Remove the ability to access servers without a server password.
Enter: ssh-add -p

3. Close the screen session. Enter: exit

NetApp StorageGRID
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GDU Troubleshooting

GDU Display Problems

Under certain circumstances, the GDU console may not display prop-
erly. For an example, see Figure 21 below.

Provisioning Repository Passphrase

Figure 21: GDU Display Problems

e If using PuTTY, change the Window Translation setting to Use font
encoding.

¢ If running GDU locally, do not use screen.

Problems with Server Status

When starting GDU, the status update of all servers may hang, or take
a long time to complete. After server status is updated, many appear
as Unknown or Pingable when it is known that the servers are Available.
This typically occurs in large grids with many servers.

To correct the problem, quit GDU, and restart with the -k option. Enter:

gdu-console -k

Starting GDU with the -k option bypasses its initial status update on
startup. The state of all servers remains Unknown in GDU until you
manually update them using the Update Status task.

GDU Log Files

The GDU logs are located on the primary Admin Node in /var/local/log/
gdu-console.log.

Missing GDU Task

NetApp StorageGRID
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If a GDU task that you must execute is missing from the Tasks panel,
check the GDU log for the reason. For instance, it is possible that a
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required ISO image is missing. To list the ISO images currently in the
Ivar/local/install directory, use the ISO List GDU action. For a sample
output, see Figure 22 below.

Figure 22: 1SO Images in /var/local/install

The label Missing, required means that the ISO image of the CD required
for the installation is not in the /var/local/install directory.

The label Not present means that an ISO image that GDU expected to
find is not in the /var/local/install directory, but GDU does not know
whether this ISO image is actually required.

Troubleshooting with screen in Multi Display Mode

The screen program is useful when two or more people need to
interact with a shell session simultaneously for troubleshooting pur-
poses. Below is an example of two users connecting to GDU at the
same time.

User 1 creates a named screen session and starts GDU.

# screen -S GDU
# gdu-console

User 2 lists the screen sessions and connects without detaching User 1.

# screen -1s
There is a screen on:
5361 .GDU (Attached)
1 Socket in /var/run/uscreens/S-root.
# screen -r -x GDU

Now both users are viewing GDU and inputs can come from either
user.
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About load_cds.py

The load_cds.py command accepts two different inputs: physical instal-
lation CDs or ISO images of the installation CDs stored in a directory
on the primary Admin Node or the HCAC’s primary reporting

Admin Node.

You can run the load_cds.py script as many times as you need.

The script automatically deletes older service pack software when you
load the latest service pack software.

If you insert the same CD twice, no new ISO is created. The existing ISO
will not be overwritten.

If the load_cds.py script fails because you inserted a CD unrecognized
by the script, eject the CD and continue with the correct CD (you do not
have start over from the first CD you loaded).

Copy ISO Files in Multi-Site Environment

In a multi-site environment, copy ISO files to the servers in the remote
location prior to installing or upgrading the software with GDU. This is
an optional, but recommended, step to reduce the number of large files
that would otherwise be transferred over a slow WAN link.

Data Center Remote Site

Primary Admin Node Servers 2...n

Figure 23: Copying Files to Remote Site
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It is not usually nec-
essary to copy the
service pack I1ISO
images since these
files are small: there
is no real gain over
letting GDU copy
the files
automatically.
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Prerequisites and Required Materials

ISO images of the StorageGRID Software CD and the Enablement
Layer for StorageGRID Software CD have been copied to the
primary Admin Node or the HCAC'’s primary reporting

Admin Node using the load_cds.py command

ssh access between the Admin Node and the servers at the remote
location

Procedure

1.

4.

At the primary Admin Node server or the HCAC’s primary report-
ing Admin Node, access a command shell and log in as root using
the password listed in the Passwords.txt file.

Copy the ISO image of the StorageGRID Software CD to a server at
the remote location. If the site has an Admin Node, copy the ISO to
it. Otherwise, use a Gateway Node, preferably a secondary. Enter:

scp /var/local/install/Bycast_StorageGRID 9.0.0_Software_\
<build>.iso <destination>:/var/local/tmp

where <destinations is the hostname or IP address of the first server
at the remote location.

Copy the ISO image of the Enablement Layer for StorageGRID
Software CD from the primaryAdmin Node to the destination
server. Enter:

scp /var/local/install/Enablement_Layer_ for_ StorageGRID_\

9.0.0_Software_<build>.iso <destination>:/var/local/tmp

If this is an upgrade, install the load_cds.py script. Enter:

scp /usr/local/sbin/load cds.py <destination>:/usr/local/sbin/

5.

8.

Log in to the server at the remote site where you copied the ISO
files. Enter: ssh <destination>

When prompted, enter the password for the remote server listed in
the Passwords.txt file.

Change to the /var/local/tmp directory. Enter: ed /var/local/tmp

Load the ISOs using the load_cds.py script. Enter:

load cds.py Bycast_StorageGRID 9.0.0_Software <build>.iso \
Enablement_ Layer for_ StorageGRID 9.0.0_Software_<build>.iso

Separate the ISO file names with a space.

Empty the temporary directory. Enter: rm -r /var/local/tmp/*

NetApp StorageGRID
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Copy the ISOs from the first server at the remote location to the

remaining servers at the remote location. For each remaining server:

a.

b.

Copy the ISO files needed for the update to the server. Enter:

scp /var/local/install/* <next_server>:/var/local/tmp

where <next_server> is the hostname or I address of the next
server at the remote site.

If this is an upgrade, install the load_cds.py script. Enter:

scp /usr/local/sbin/load_cds.py <next_ server>:/usr/local/sbin/

C.

d.
e.

Log in to the next server at the remote site where you copied the
ISO files. Enter: ssh <next_server>

When prompted, enter the password for the remote server listed
in the Passwords.txt file.

Change to the /var/local/tmp directory. Enter: cd /var/local/tmp

Load the ISOs using the load_cds.py script. Enter:

load cds.py Bycast_StorageGRID 9.0.0_Software_ <build>.iso \
Enablement_Layer for StorageGRID 9.0.0_Software_<build>.iso

f.

g.
h.

Separate the ISO file names with a space.
Empty the temporary directory. Enter: rm -r /var/local/tmp/*
End the ssh session. Enter: exit

Repeat from step a for each server at the remote site.

10. End the ssh session on the remote server. Enter: exit

11. Log out of the Admin Node. Enter: exit
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Install Grid Software
Manually

Introduction

This chapter includes procedures to install StorageGRID software
manually. While the preferred and recommended procedure to install
grid software is with GDU, the manual installation of grid software is
sometimes required.

NOTE Always use GDU to install grid software on the primary Admin Node.

Once you start installing grid software on a server manually, you
cannot switch to GDU to complete the installation of that server.

The manual grid software installation procedure uses the glsetup and
postinstall scripts. Table 12 below compares the GDU tasks to the equiv-
alent manual installation scripts.

Table 12: GDU Tasks and Equivalent Installation

Scripts
GDU Task Equivalent Scripts
Install Software glsetup.sh and postinstall.rb activate
Enable Services postinstall.rb start
Update Software updategrid.rb
NetApp StorageGRID 121
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Install Grid Software Manually

Prerequisites
e The grid software has been installed on the primary Admin Node.
* You have a copy of the ISOs from the /var/local/install/ directory of

the primary Admin Node. Note that the Service Pack ISOs are only
required if a service pack is available for the release:

* Bycast_StorageGRID_9.0.0_Software_<build>.iso
* Enablement_Layer for StorageGRID_9.0.0_Software_<build>.iso

* Bycast_StorageGRID_9.0.<servicepack>_Software_Service Pack_
<build>.iso

* Enablement_Layer for_StorageGRID_9.0.<servicepack>_Software_
Service_Pack_<build>.iso

* For Archive Nodes, the ISO of the TSM client packages CD
e Linux has been installed on the server.

e The virtual machines have prepared. For more information, see
“Prepare Virtual Machines” on page 23.

Procedure

In each step, omit the service pack CDs if a service pack is not available
for the release.

1. Log in to the server as root using the password listed in the Pass-
words.txt file.

2. Copy these ISO images to the server’s /var/local/tmp directory:
* Bycast_StorageGRID_9.0.0_Software_<build>.iso
* Enablement_Layer for StorageGRID_9.0.0_Software_<build>.iso

* Bycast_StorageGRID_9.0.<servicepack>_Software
_Service_Pack_<build>.iso

* Enablement_Layer for_ StorageGRID_9.0.<servicepack>_Software_
Service_Pack_<build>.iso

* For an Archive Node, the ISO of the TSM client packages CD
3. Remove any USB flash drive from the server.

Change to the /var/local/tmp directory. Enter: ea /var/local/tmp
5. Mount the ISO of Software Service Pack CD. Enter:

mount -o loop,ro <service pack CD iso> /cdrom

6. Install the updated load_cds.py script from the Service Pack CD.
Enter: /cdrom/install-load-cds
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Do not copy the
images to /var/local/
install directly. Use
the load_cds.py
script instead
because the script
verifies the integrity
of the ISOs.
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11.

12.

13.

Unmount the Service Pack CD ISO. Enter: umount /cdrom

Copy the ISOs to the /var/local/install/ directory using the load_cds.py
script. Enter:

load_cds.py Bycast_StorageGRID 9.0.0_Software_<build>.iso \
Enablement_Layer for_ StorageGRID_9.0.0_Software_<build>.iso
\

Bycast_StorageGRID_9.0.<servicepack>_Software_Service_\
Pack_<build>.iso Enablement_Layer_ for StorageGRID_\
9.0.<servicepack>_Software_Service_Pack_<build>.iso

Remove the ISOs from /var/local/tmp. Enter: rm -r /var/local/tmp

. Set up the server:

a. Run the setup script. Enter:

glsetup.sh --iso=/var/local/install/Enablement_Layer\
_for StorageGRID 9.0.0_Software_<build>.iso

b. Follow the prompts to read and accept the software license
agreement.

c. If prompted to reformat partitions, for example, if the server
storage was previously configured and you are re-running the
glsetup script, enter y to reformat the partition, orn to preserve
the existing partition.

The script ends with the message “Completed Enablement Layer
setup” when it completes normally.

If prompted to reboot the server:
a. Enter:y

b. When the server finishes rebooting, log in as root using the
password listed in the Passwords.txt file.

Activate the software:
a. If this is for an Archive Node that uses TSM for middleware,

enter:
postinstall.rb activate --iso=/var/local/install\
/Bycast_StorageGRID_9.0.0_Software_<build>.iso \
--iso=<TSM ISO name>
b. For all other cases, enter:
postinstall.rb activate --iso=/var/local/install\
/Bycast_StorageGRID 9.0.0_Software_<build>.iso
Upon completion of activation, the message “StorageGRID activation
completed” appears.

Mount the StorageGRID Software Service Pack CD image. Enter:

mount -o loop,ro /var/local/install/Bycast_StorageGRID_\
9.0.<servicepack>_Software_Service_Pack_<build>.iso /cdrom
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14.

15.

16.

17.

18.

Run the update script to apply the service pack. Enter:

/cdrom/swupdate/updategrid.rb --iso=/var/local/install\
/Enablement_Layer for_ StorageGRID 9.0.<servicepack>_\
Software_Service_Pack_<build>.iso

If prompted to reboot:
a. Enter: reboot

b. When the server finishes rebooting, log in as root using the
password listed in the Passwords.txt file.

Repeat this procedure from step 1 for any other grid nodes that
require manual installation.

NOTE If you are preforming a manual software installation as part of a
recovery procedure, do not start software until instructed.

If you are installing an entire StorageGRID system:

a. Start the grid software. If servers have connectivity to the
primary Admin Node, use GDU to start grid software as
described in “Start Grid Software” on page 53.

b. To complete grid installation, ensure that you load NMS con-
figuration settings as described in “Load NMS Configuration
Settings” on page 55.

c. Ensure that you log out of any server that was manually
installed. Enter: exit

If necessary, manually start grid software. Enter:

postinstall.rb start ; exit

Troubleshooting

glsetup Script Fails

If the script reports an error, run the script again with the verbose
option (enter: glsetup.sh --verbose) to gather more information
about the issue. After the issue has been resolved, you can safely rerun
glsetup.sh.

Wrong Answer in glsetup When Formatting Partitions

124

The glsetup.sh script checks if the required disk partitions exist and are
mounted. If they are (because you are re-running the glsetup.sh script),
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glsetup.sh identifies each partition, displays a warning message, and
asks if you want to reformat the existing partition.

If you inadvertently enter No and then rerun glsetup.sh to correct the
issue, the prompt to reformat the partition does not appear.

Force Prompt to Appear

1. Manually unmount the disk partitions, using the Linux umount
command.

2. Re-run the setup utility. Enter: glsetup.sh --enable-reformat

postinstall Script Fails

If the postinstall script is halted or fails before it completes, restart the
installation procedure on that server from the beginning. The postin-
stall script cannot be safely run twice, in whole or in part.
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Required Ports

Inter-grid Communication

Servers that are part of a grid must communicate with one another
using the listener ports listed in Table 14 below. These ports are
required on the grid network.

Table 13: Inter-grid Communication Ports

Outgoing Connection
from Gateway Node

Port Description Connecting To to Service

1501 (TCP) ADC service Servers hosting an Yes
connection ADC service.

1502 (TCP) LDR service Servers hosting an No
connection LDR service.

1503 (TCP) CMS service ServershostingaCMS No
connection service.

1504 (TCP) NMS service Servers hosting an No
connection NMS service.

1505 (TCP) AMS service Servers hosting an No
connection AMS service.

1506 (TCP) SSM service Server hostinganSSM  No
connection service (all servers).

1507 (TCP) CLB service Server hosting a CLB Yes
connection service.

1508 (TCP) CMN service Server hostinga CMN  No
connection service.

1509 (TCP) ARC service Server hosting an No
connection ARC service.

1510 (TCP) FSG service Server hosting an FSG ~ Yes
connection service.

NetApp StorageGRID
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Table 13: Inter-grid Communication Ports (cont.)

Outgoing Connection
from Gateway Node

Port Description Connecting To to Service
1602 (TCP) CMS maintenance Server hostinga CMS  No
connection service.
2013(TCP) NMS service Server hosting a High  No

connection Capacity Admin
Cluster.
18080, 18081 HTTP query/ retrieve ~ Servers hosting an Yes
(TCP) and ingest LDR service in grids
that also have FSG
services.
1139 (TCP) LDR replication Servers hosting an No
LDR service.
11139 (TCP) ARC replication Servers hosting an No
ARC service.
22 (TCP) ssh All grid servers for Yes
centralization of
installation, update,
and other mainte-
nance procedures.
123 (UDP) ntp All servers. Yes
694 (UDP) ha-client Servers hosting a Yes

High Availability FSG

Client to Grid Communication

128

Clients communicate with grid servers to ingest and retrieve content.
The connections differ depending on the protocols chosen to ingest
and retrieve content. Consult Table 14 on page 129 to choose which
ports will ingest and retrieve content. Third-party software (such as
hardware monitoring) may require ports not listed here. Other client
software may be used to connect with grid servers for monitoring and
maintenance. In this case, additional ports are needed depending on
the degree to which external monitoring and access is required.
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Table 14: Client to Grid Communication Ports

Port

Description

Connecting To

Gateway Node
Needs Port Open to
Client Network

22 (TCP)

ssh

Servers being used as an
access point into the grid for
software installation, update,
and maintenance.

No

111 (TCP/UDP)

portmap

Servers hosting an FSG
service and offering an NFS
share.

Yes

903 (TCP/UDP)

rpc.mountd

Servers hosting an FSG
service and offering an NFS
share.

Yes

904 (TCP/UDP)

nlm

Servers hosting an FSG
service and offering an NFS
share.

Yes

2049 (TCP/UDP)

nfsd

Servers hosting an FSG
service and offering a NFS
share.

Yes

137 (UDP)

netbios-ns

Servers hosting an FSG
service and offering a CIFS
share.

Yes

138 (TCP)

netbios-dgm

Servers hosting an FSG
service and offering a CIFS
share.

Yes

139 (TCP)

netbios.ssn

Servers hosting an FSG
service and offering a CIFS
share.

Yes

445 (TCP)

microsoft-ds

Servers hosting an FSG
service and offering a CIFS
share.

Yes

514 (TCP)

shell

Servers hosting an FSG
service and offering an RSH
connection.

Yes

161 (TCP/UDP)

snmp

Servers that are being moni-
tored via SNMP.

Yes
Dependant on where
servers are located.
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Table 14: Client to Grid Communication Ports (cont.)

Gateway Node
Needs Port Open to

Port Description Connecting To Client Network
162 (TCP/UDP) snmptrap Servers that are being moni-  Yes
tored via SNMP. Dependant on where
servers are located.
80 (TCP) HTTP Servers hosting an NMS No
service.
443 (TCP) HTTPS Servers hosting an NMS No
service.
8080, 8081 (TCP)  HTTP query/ The StorageGRID API Yes
retrieve and ingest  (SGAPI) or CDMI on
gateway servers hosting a
CLB.
18080, 18081 HTTP query/ The SGAPI or CDMI on No
(TCP) retrieve and ingest  servers hosting the LDR
service (most grids access
these services through a
CLB).
130 NetApp StorageGRID
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Connection requirements for the NMS management
interface and the server command shell

Browser Settings

Verify Internet Explorer Settings

Go to Tools » Internet Options » General

In the Browsing history box, click Settings.

Temporary Internet Files and History Settings

If you are using Internet Explorer, verify that the settings for tempo-
rary internet files, security and privacy are correct.

3. For Check for newer versions of stored pages, select Automatically.

x|

~Temporary Internet Files

Internet Explorer stores copies of webpages, images, and media
for faster viewing later.

Check for newer versions of stored pages:
" Every time I visit the webpage
(o Every time I start Internet Explorer

Disk space to use (8-1024MB) I 50 3:

(Recommended: 50-250MB)

Current location:
C:\AppData'Local\Microsoft\Windows TemporarInternet Files\,

Move folder... View objects View files

History
Specify how many days Internet Explorer should save the list
of websites you have visited.

Days to keep pages in history: I 20 3:

Figure 24: Temporary Files Setting

4. Go to Tools » Internet Options » Security » Custom Level and
ensure that the Active Scripting setting is Enable.

NetApp StorageGRID
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Security Settings - Internet Zone

Settings

O Prompk -
= Seripting
S| Active scripting
(O Disable
(® Enable
O Prompk

Figure 25: Active Scripting Setting

5. Go to Tools » Internet Options » Privacy and ensure that the
privacy setting is Medium or lower (cookies must be enabled).

Enable Pop-ups

To make any changes to passwords, you must ensure that your
browser allows pop-up windows. For more information on allowing
pop-up windows, see your browser’s documentation.

NMS Connection Procedure

Connecting to the NMS MI at the customer site requires access to the
customer’s network.

If the grid is configured with a High Capacity Admin Cluster (HCAC),
you can only connect to the reporting Admin Node. You cannot
connect to the processing Admin Node. In a grid with two

Admin Nodes or HCACs, you can connect to either Admin Node or
HCACS' reporting Admin Node. Each Admin Node or HCAC
displays a similar view of the grid; however, alarm acknowledgments
made at one Admin Node or HCAC are not copied to the other
Admin Node or HCAC. It is therefore possible that the Grid Topology
tree will not look the same for each Admin Node or HCAC.

1. Work with the customer system administrator to establish the
physical network connection to the service laptop. Using the cus-
tomer’s network rather than a direct connection within the rack
verifies that the interface is accessible using the same infrastructure
the customer uses.

2. From the Configuration.txt file, note the IP address of the
Admin Node (reporting Admin Node in an HCAC) on the
customer network. This is needed to access the NMS MI.
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3. From the Passwords.txt file, note the NMS MI password for the
Vendor account or the Admin account.

Launch the web browser.
5. Open the address https://<IP_address>

where </IP_address> is the address of the Admin Node (reporting
Admin Node in an HCAC) on the customer network specified in
the Configuration.txt file.

Security Certificate

NetApp StorageGRID
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Depending on your version of Windows and web browser, you may be
warned of a problem with the security certificate when you access the
NMS MI URL.

'g) There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.
The security certificate presented by this website was issued for a different website's address.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
Server.

We recommend that you close this webpage and do not continue to this website.
& Click here to dose this webpage.
&3 Continue to this website (not recommended).

@ More information
Figure 26: Example of a Security Alert Window

If this appears, you can either:

e Proceed with this session. The alert will appear again the next time
you access this URL.

* Install the certificate. Follow the instructions of your browser.

The NMS Ml uses a self-signed certificate. For information on import-
ing this certificate into a browser see the browser's documentation.
Note that the self-signed certificate used by the NMS MI is based on
the grid’s IP address. The expected URL to the interface is this IP
address and not a domain name. In cases where the domain name is
used, browsers may not be able to match the self-signed certificate to
the identity of the NMS server. For more information see the browser's
documentation.
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Log In

1. Enter the username Vendor for full access to the NMS ML If you are
not making grid-wide configuration changes, you can also use the
Admin account.

2. Enter the password for the NMS MI specified in the Passwords.txt
file.

“ StorageGRID®

Netwerk Management System

NetApp

Gofurther, faster

Figure 27: NMS MI Login Window

Log Out

When you finish your NMS MI session, log out to keep the system
secure.

1. Click Logout Les2ut By Jocated at the top-right corner of the screen.
The logging out message appears.

2. You may safely close the browser or use other applications.

NOTE Failure to log out may give unauthorized users access to your NMS
session. Simply closing your browser is not sufficient to log out of the
session.

Command Shell Access Procedures

Log In
¢ At the server, access a command shell and log in as root using the
password listed in the Passwords.txt file.
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Log Out

1.
2.

Enter exit to close the current command shell session.

Press <Alt>+<F7> to return to the Server Manager GUI.

Accessing a Server Remotely

NetApp StorageGRID
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There are three ways to connect to a server remotely using ssh:

From any server, using the remote server password

From the primary Admin Node, using the ssh private key
password

From the primary Admin Node, without entering any password
except the ssh private key password once

The primary Admin Node acts as an ssh access point for other grid
servers. The procedures to change the ssh private key password and to
enable passwordless access from the primary Admin Node to other
servers are described in the “Network Configuration” chapter of the
Administrator Guide.

Connect Using the Remote Server Password

1.
2.

Log in to any local server.
Enter: ssh <1P_address>
where <IP_address> is the IP address of the remote server.

When prompted, enter the password for the remote server listed in
the Passwords.txt file.

Connect Using the ssh Private Key Password

Log in to the primary Admin Node.

Enter: ssh <hostname>

where <hostname> is the name of the remote server.
—or—

Enter: ssh <IP_address>

where <IP_address> is the I address of the remote server.

When prompted, enter the SSH Access Password listed in the Pass-
words.txt file.
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Connect to a Server without Using a Password

1. Log in to the primary Admin Node.

2. Add the ssh private key to the ssh agent to allow the primary
Admin Node passwordless access to the other servers in the grid.
Enter: ssh-add

You need to add the ssh private key to the ssh agent each time you
start a new shell session on the primary Admin Node.

3. When prompted, enter the SSH Access Password.

You can now access any grid server from the primary Admin Node
via ssh without entering additional passwords.

4. When you no longer require passwordless access to other servers,
remove the private key from the ssh agent. Enter: ssh-ada -p

5. Log out of the primary Admin Node command shell. Enter: exit

Using GNU screen

136

The GNU screen program, which is installed by default, allows you to
manage many shell instances concurrently, to connect to the same
session from different locations, to detach from a session without
stopping the program running within the session, and to resume a
session that was previously detached.

The screen program decouples the terminal emulator from the running
program. This means that the program keeps running even if you
detach from the session or close the terminal emulator, or lose the
connection.

Consider using screen when you execute maintenance procedures
remotely and there is a possibility of losing the connection or where it
would be useful to 'hang up' and connect back later. For example, you
may want to use screen when cloning a CMS database since this proce-
dure can take a few hours to complete.

1. Login to a server remotely. For more information, see “Accessing a
Server Remotely” on page 135.

Start screen. Enter: screen

Enter the command or script you need to execute in the new
window.

4. To quit the screen session, enter: exit

Screen has a number of command-line options. For example:
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-1s

-S <name>

-X <name>

To detach a session. The running program disappears
from the terminal. However, it continues to run behind
the scenes.

To resume a detached screen session. This brings the
program back to your terminal.

To list existing sessions.
To name a session.

To attach to a screen session that is already attached by
another user (multi display mode). Either user can
interact with the screen session or detach from it.

See below for an example of how to use screen.

Create named session —_ g # screen -S CMScloneproc
# <commands to start cloning process>
Detach screen session —»# <CTRL+A> <CTRL+D>
List screen sessions —pp-# screen -1ls
There is a screen on:

NetApp StorageGRID
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20849 .CMScloneproc (Detached)

1 Socket in /var/run/uscreens/S-root.
Reattach screen session—»# screen -d -r CMScloneproc

For more information, display the man page for screen, and consult the
GNU official web site http://www.gnu.org/software/screen/.
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ACL
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FSG

ADC

ADE

Admin Node

AMS

API

API1
Gateway Node

ARC
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Access control list—Specifies what users or groups of users are
allowed to access an object and what operations are permitted, for
example read, write, and execute.

In an HAGC, the FSG that is currently providing read-write service to
clients. See also “FSG replication group”.

Administrative Domain Controller — A software component of the
StorageGRID system. The ADC service maintains topology informa-
tion, provides authentication services, and responds to queries from
the LDR, CMS, CMN, and CLB. The ADC service is found on the
Control Node.

Asynchronous Distributed Environment— Proprietary development
environment used as a framework for grid services within the NetApp
StorageGRID Software.

A building block of the StorageGRID system. The Admin Node
provides services for the web interface, grid configuration, and audit
logs. See also “reporting Admin Node”, “processing Admin Node”,

“primary Admin Node”, “Audit Node”, and “HCAC”".

Audit Management System — A software component of the Storage-
GRID system. The AMS service monitors and logs all audited system
events and transactions to a text log file. The AMS service is found on
the Admin Node — reporting Admin Node in a High Capacity Admin
Cluster (HCAC) and the Audit Node.

Application Programming Interface— A set of commands and func-
tions, and their related syntax, that enable software to use the
functions provided by another piece of software.

Application Programming Interface Gateway Node provides read-
write access for HTTP clients (via StorageGRID API or CDMI). API
Gateway Nodes are configured to include a “CLB” service, but not an
“FSG” service. As a result, API Gateway Nodes do not support NFS/
CIFS file systems and are not configured as part of a replication group.

Archive— A software component of the StorageGRID system. The
ARC service manages interactions with archiving middleware that
controls nearline archival media devices such as tape libraries. The
ARC service is found on the Archive Node.
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Archive Node

Audit Node

audit message

atom

AutoYaST

BASE64

Basic Gateway
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replication
group

Binding

bundle

business
continuity
failover

A building block of the StorageGRID system. The Archive Node
manages storage of data to nearline data storage devices such as such
as tape libraries (via IBM Tivoli® Storage Manager).

A building block of the StorageGRID system. The Audit Node logs all
audit system events. It is an optional grid node that is generally
reserved for larger grid deployment.

Information about an event occurring in the StorageGRID system that
is captured and logged to a file.

Atoms are the lowest-level component of the container data structure,
and generally encode a single piece of information. (Containers are
sometimes used when interacting with the grid via the StorageGRID
API).

An automated version of the Linux installation and configuration tool
YaST (“Yet another Setup Tool”), which is included as part of the SUSE
Linux distribution.

A standardized data encoding algorithm that enables 8-bit data to be
converted into a format that uses a smaller character set, enabling it to
safely pass through legacy systems that can only process basic (low
order) ASCII text excluding control characters. See RFC 2045 for more
details.

A Basic Gateway replication group contains a primary FSG and one or
more secondary FSGs.

The persistent assignment of a grid service (for example, an FSG or
SSM) to the consolidated NMS service or processing NMS service. This
assignment is based on grid topology (consolidated Admin Node or
HCAC). See also “Admin Node”.

A structured collection of configuration information used internally by
various components of the grid. Bundles are structured in container
format.

A business continuity failover within a Gateway Node replication
group is one where a secondary Gateway Node is manually config-
ured to act as a primary after the primary Gateway Node fails. Clients
can continue to read and write to the grid after they are manually redi-
rected to the acting primary. This is a temporary measure to maintain
service while the primary Gateway Node is repaired.
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Content Block Identifier — A unique internal identifier of a piece of
content within the StorageGRID system.

Cloud Data Management Interface — An industry standard defined by
SNIA that includes a RESTful interface for object storage. For more
information, see http://www.snia.org/cdmi.

Classless Inter-Domain Routing — A notation used to compactly
describe a subnet mask used to define a range of IP addresses. In CIDR
notation, the subnet mask is expressed as an IP address in dotted
decimal notation, followed by a slash and the number of bits in the
subnet. For example, 192.0.2.0/24.

Common Internet File System — A file system protocol based on
SMB (Server Message Block, developed by Microsoft) which coexists
with protocols such as HTTP, FTP, and NFS.

Connection Load Balancer — A software component of the Storage-
GRID system. The CLB service provides a gateway into the grid for
clients connecting via the HTTP protocol. The CLB service is part of
the Gateway Node.

See “CDMI” on page 141.

Configuration Management Node— A software component of the
StorageGRID system. The CMN service manages system-wide
configuration and grid tasks. The CMN service is found on the
primary Admin Node.

Content Management System — A software component of the Storage-
GRID system. The CMS service manages content metadata and con-
tent replication according to the rules specified by the ILM policy. The
CMS service is found on the Control Node.

In HTTP, an instruction in the request header such as GET, HEAD,
DELETE, OPTIONS, POST, or PUT. Also known as an HTTP method.

A container is a data structure used by the internals of grid software.
In the StorageGRID API, an XML representation of a container is used
to define queries or audit messages submitted using the POST
command. Containers are used for information that has hierarchical
relationships between components. The lowest-level component of a
container is an atom. Containers may contain 0 to N atoms, and 0 to N
other containers.
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Control Node
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deduplication

distributed CMS

DR

EMR

Enablement
Layer
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142

See “CBID”.

See “UUID”.

Admin Node hosting the consolidated NMS service. Can be the
primary Admin Node.

Hosted by the consolidated Admin Node. It is the equivalent of a
combined reporting NMS and processing NMS service. See also
I/NMS/I A

A building block of the StorageGRID system. The Control Node
provides services for managing content metadata and content
replication.

Null-terminated, variable length string.
Data Center site.

If enabled, when the grid identifies two files as being identical, it
“deduplicates” them by redirecting all content handles to point to a
single stored instance of the file. The end result is that only the number
of copies required by the ILM policy are stored in the grid. The feature
was designed for use with applications that save two identical copies
of a file to the grid via different Gateway Nodes.

NOTE Deduplication is deprecated and no longer supported.

A CMS that uses metadata replication. See also “metadata
replication”.

Disaster Recovery site.

Electronic Medical Records— A computerized system for managing
medical data that may be interfaced to the grid.

The Enablement Layer for StorageGRID Software CD is used during
installation to customize the Linux operating system installed on each
grid server. Only the packages needed to support the services hosted
on the server are retained, which minimizes the overall footprint
occupied by the operating system and maximize the security of each
grid node.

Fixed Content Storage —a class of stored data where the data, once
captured, is rarely changed and must be retained for long periods of
time in its original form. Typically this includes images, documents,
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and other data where alterations would reduce the value of the stored
information.

File System Gateway— A software component of the StorageGRID
system. The FSG service enables standard network file systems to
interface with the grid. The FSG service is found on the

Gateway Node.

A replication group is a group of FSGs that provide grid access to a
specified set of clients. Within each replication group, there is a
primary FSG (or a primary FSG cluster) and one or more secondary
FSGs. The primary FSG allows clients read and write access to the
grid, while storing file system information (file pointers) for all files
saved to the grid. The secondary FSG “replicates” file system informa-
tion, and backs up this information to the grid on a regular schedule.

A building block of the StorageGRID system. The Gateway Node
provides connectivity services for NFS/CIFS file systems and the
HTTP protocol.

See “FSG replication group”.

Grid Deployment Utility — A StorageGRID software utility used to
facilitate the installation and update of software on all grid nodes.
GDU is installed and available on the primary Admin Node.

Grid Provisioning Tool — a software tool included with StorageGRID
software that permits you to provision a grid for installation, upgrade,
maintenance, or expansion. GPT creates and maintains an encrypted
“repository” of information about the grid that is required to maintain
the grid and recover failed grid nodes.

A Microsoft Windows based application used to create the configura-
tion information needed to install, expand, and maintain a grid. It
produces a grid specification file containing the grid’s configuration
details (in an XML format) required for the successful deployment of a
StorageGRID system.

A BASE64 encoded block of cryptographically signed data that
contains the grid ID which must match the grid ID (gid) element in the
grid specification file. See also “provisioning”.

The name of the StorageGRID system building blocks, for example
Admin Node or Control Node. Each type of grid node consists of a set
of services running on a server.
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Grid
Specification
File

Grid Task

HAGC

HCAC

HTTP

HTTPS

ILM

inode

KVM

An XML file that provides a complete technical description of a
specific grid deployment. It describes the grid topology, and specifies
the hardware, grid options, server names, network settings, time syn-
chronization, and gateway clusters included in the grid deployment.
The Deployment Grid Specification file is used to generate the files
needed to install the grid.

A managed sequence of actions that are coordinated across a grid to
perform a specific function (such as adding new node certificates).
Grid Tasks are typically long-term operations that span many entities
within the grid. See also “Task Signed Text Block”.

High Availability Gateway Cluster—An HAGC is a primary gateway
cluster that consists of a main FSG and a supplementary FSG. A high
availability gateway replication group optionally includes one or more
secondary FSGs.

High Capacity Admin Cluster—An HCAC is the clustering of a
reporting Admin Node and processing Admin Node. The result is an
increase to a grid’s capacity for grid services and thus grid nodes. See

also “reporting Admin Node”, “processing Admin Node”, and
“Admin Node”.

Hyper-Text Transfer Protocol — A simple, text based client/server
protocol for requesting hypertext documents from a server. This
protocol has evolved into the primary protocol for delivery of informa-
tion on the World Wide Web.

Hyper-Text Transfer Protocol, Secure—URIs that include HTTPS
indicate that the transaction must use HTTP with an additional
encryption/authentication layer and often, a different default port
number. The encryption layer is usually provided by SSL or TLS.
HTTPS is widely used on the internet for secure communications.

Information Lifecycle Management— A process of managing content
storage location and duration based on content value, cost of storage,
performance access, regulatory compliance and other such factors.

On Unix/Linux systems, a data structure that contains information
about each file, for example, permissions, owner, file size, access time,
change time, and modification time. Each inode has a unique inode
number.

Keyboard, Video, Mouse— A hardware device consisting of a key-
board, LCD screen (video monitor), and mouse that permits a user to
control all servers in a rack.
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Local Area Network—A network of interconnected computers that is
restricted to a small area, such as a building or campus. A LAN may be
considered a node to the Internet or other wide area network. Contrast
with WAN.

Time duration for processing a transaction or transmitting a unit of
data from end to end. When evaluating system performance, both
throughput and latency need to be considered. See also “throughput”.

Local Distribution Router — A software component of the StorageGRID
system. The LDR service manages the storage and transfer of content
within the grid. The LDR service is found on the Storage Node.

See “object store”.

In an HAGC, the FSG that is configured to be the active primary FSG
by default.

Information related to or describing an object stored in the grid, for
example file ingest path or ingest time.

In a grid that uses metadata replication, a CMS makes copies of
metadata on the subset of CMSs that are in its CMS replication group,
and then applies the grid’s ILM policy to content metadata. In the
NMS MI, CMSs that use metadata replication display the Metadata
component. Called “distributed CMS” in a previous release.

In a grid that uses metadata synchronization, a CMS synchronizes
metadata with all other read-write CMSs in the grid. Called “synchro-
nized CMS” in a previous release.

NOTE Metadata synchronization is deprecated.

Management Interface —The web-based interface for managing and
monitoring the StorageGRID system provided by the NMS software
component. See also “NMS”.

A set whose elements are unique names. There is no guarantee that a
name in one namespace is not repeated in a different namespace.

A term describing data storage that is neither “online” (implying that
it is instantly available like spinning disk) nor “offline” (which could
include offsite storage media). An example of a nearline data storage
location is a tape that is loaded in a tape library, but is not necessarily
mounted.
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processing
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processing NMS
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Network File System — A protocol (developed by SUN Microsystems)
that enables access to network files as if they were on local disks.

Network Management System — A software component of the Storage-
GRID system. The NMS service provides a web-based interface for
managing and monitoring the StorageGRID system. The NMS service
is found on the Admin Node (both the reporting and processing
Admin Nodes in an HCAC). There are three types of NMS service:
consolidated, reporting, and processing. See also “MI” and

“Admin Node”.

An identification number assigned to a grid service within the Storage-
GRID system. Each service (such as an CMS or ADC) in a single grid
must have a unique node ID. The number is set during system config-
uration and tied to authentication certificates.

Network Time Protocol — A protocol used to synchronize distributed
clocks over a variable latency network such as the internet.

A configured file system on a disk volume. The configuration includes
a specific directory structure and resources initialized at system
installation.

A StorageGRID process that splits a large object into a collection of
small objects (segments) and creates a segment container to track the
collection. The segment container contains the UUID for the collection
of small objects as well as the header information for each small object
in the collection. All of the small objects in the collection are the same
size. See also “segment container”.

Object Identifier — The unique identifier of an object.

Admin Node that hosts the CMN service. There is one per grid. In an
HCAC, the CMN service is hosted by the primary reporting
Admin Node. See also “Admin Node” and “HCAC”.

In an FSG replication group, the FSG that provides read-write services
to clients. See also “FSG replication group”.

Performs attribute and configuration processing that is passed on to
the reporting Admin Node as part of a High Capacity Admin Cluster.
See also “reporting Admin Node” and “HCAC”.

Hosted by the processing Admin Node. Provides attribute and data
processing functionality. Only operates in conjunction with a reporting
Admin Node and the reporting NMS. See also “NMS”.
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The process of editing the Grid Specification File (if required) and gen-
erating a new or updated SAID package and GPT repository. This is
done on the primary Admin Node using the provision command. The
new or updated SAID package is saved to the Provisioning Media. See
also “Grid Specification File” and “SAID”.

A simple majority: 50% + 1 of the total number in the grid. In Storage-
GRID software, some functionality may require a quorum of the total
number of some types of service to be available.

Reports attribute and configuration information to web clients as part
of a High Capacity Admin Cluster. See also “processing Admin Node”
and “HCAC”.

Hosted by the reporting Admin Node. Reports status information
about the grid and provides a browser-based interface. Only operates
in conjunction with a processing Admin Node and the processing
NMS. See also “NMS”.

Software Activation and Integration Data—Generated during provi-
sioning, the SAID package contains site-specific files and software
needed to install a grid.

A free suite of programs which implement the Server Message Block
(SMB) protocol. Allows files and printers on the host operating system
to be shared with other clients. For example, instead of using telnet to
log in to a Unix machine to edit a file there, a Windows user might
connect a drive in Windows Explorer to a Samba server on the Unix
machine and edit the file in a Windows editor. A Unix client called
“smbclient”, built from the same source code, allows FTP-like access to
SMB resources.

Serial Advanced Technology Attachment—A connection technology
used to connect servers and storage devices.

Small Computer System Interface— A connection technology used to
connect servers and peripheral devices such as storage systems.

A read-only FSG that may also perform backups of the FSG replication
group. See also “FSG replication group”.

If enabled, access to content ingested into the grid is restricted to the
application, HTTP client, or FSG replication group that ingested the
object.
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An object created by StorageGRID during the segmentation process.
Object segmentation splits a large object into a collection of small
objects (segments) and creates a segment container to track the collec-
tion. A segment container contains the UUID for the collection of
segmented objects as well as the header information for each segment
in the collection. When assembled, the collection of segments creates
the original object. See also “object segmentation”.

Used when referring specifically to hardware.

Application that runs on all grid servers, supervises the starting and
stopping of grid services, and monitors all grid services on the server.

A unit of the StorageGRID software such as the ADC, CMS or SSM.

StorageGRID Application Programming Interface— A set of
commands and functions, and their related syntax, that provides
HTTP clients with the ability to connect directly to the StorageGRID
system (to store and retrieve objects) without the need for a
Gateway Node.

SUSE Linux Enterprise Server — A commercial distribution of the SUSE
Linux operating system, used with the StorageGRID system.

Structured Query Language— An industry standard interface
language for managing relational databases. An SQL database is one
that supports the SQL interface.

Secure Shell — A Unix shell program and supporting protocols used to
log in to a remote computer and execute commands over an authenti-
cated and encrypted channel.

Server Status Monitor — A unit of the StorageGRID software that
monitors hardware conditions and reports to the NMS. Every server in
the grid runs an instance of the SSM. The SSMS service is present on all
grid nodes.

Secure Socket Layer —The original cryptographic protocol used to
enable secure communications over the internet. See also “TLS”.

In an HAGC, the FSG that is available to take over and provide read-
write services to clients in event of the failure of the active primary
FSG.

A building block of the StorageGRID system. The Storage Node
provides storage capacity and services to store, move, verify, and
retrieve objects stored on disks.
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A registered trademark of NetApp Inc. for their fixed-content storage
grid architecture and software system.

See “SGAPI”.

See “object store”.

In an HAGC, the FSG that is configured to be the standby primary FSG
by default.

See “SLES” —SUSE Linux Enterprise Server.

See “metadata synchronization”.

A BASE64 encoded block of cryptographically signed data that
provides the set of instructions that define a grid task.

Transmission Control Protocol / Internet Protocol — A process of
encapsulating and transmitting packet data over a network. It includes
positive acknowledgment of transmissions.

The amount of data that can be transmitted or the number of transac-
tions that can be processed by a system or subsystem in a given period
of time. See also “latency”.

Transport Layer Security — A cryptographic protocol used to enable
secure communications over the internet. See RFC 2246 for more
details.

The parameters, such as the byte order and compression method,
needed to exchange data between systems.

Tivoli® Storage Manager — IBM storage middleware product that
manages storage and retrieval of data from removable storage
resources.

Universal Resource Identifier — A generic set of all names or addresses
used to refer to resources that can be served from a computer system.
These addresses are represented as short text strings.

A language-independent international abbreviation, UTC is neither
English nor French. It means both “Coordinated Universal Time” and
“Temps Universel Coordonné”. UTC refers to the standard time
common to every place in the world.

Universally Unique Identifier —Unique identifier for each piece of
content in the StorageGRID. UUIDs provide client applications with a
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VM

XFS

WAN

XML

content handle that permits them to access grid content in a way that
does not interfere with the grid’s management of that same content. A
128-bit number which is guaranteed to be unique. See RFC 4122 for
more details.

Virtual Machine— A software platform that enables the installation of
an operating system and software, substituting for a physical server
and permitting the sharing of physical server resources amongst
several virtual “servers”.

A scalable, high performance journaled file system originally devel-
oped by Silicon Graphics.

Wide Area Network — A network of interconnected computers that
covers a large geographic area such as a country. Contrast with
IILAN// .

eXtensible Markup Language— A text format for the extensible repre-
sentation of structured information; classified by type and managed
like a database. XML has the advantages of being verifiable, human
readable, and easily interchangeable between different systems.
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Index

Symbols
/var/local/ license-accepted.txt
file 13

/var/local/install directory 112,
116

A

ACLs
defined 139
activation files 87
active primary FSG
defined 139
ADC
defined 139
ADE
defined 139
Admin Node
defined 139
HCAC installation 54
installation 52
start software on primary
Admin Node 54
alarms 56
AMS
defined 139
API
defined 139
API Gateway Node
defined 139
ARC
defined 139
Archive Node
defined 140
installation 62
set custom alarms 71
TSM integration 18
atom
defined 140
audit client share, verify 86
audit messages
defined 140
Audit Node
defined 140
AutoYaST
defined 140
Available server state, in GDU 112

backup
force initial backup 72
Backup Provisioning USB flash
drive 99
Backup Result attribute 73
backup schedule
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Next Scheduled Backup
attribute 72
backup-to-usb-key command 42,
98, 99, 101
BASE64
defined 140
basic gateway replication
group 140
BOM
VM 24
browser
connect to NMS MI 132
pop-ups 132
security certificates 133
settings 131
bundle
defined 140
business continuity failover 140
Busy state, in GDU 112

C

CBID

defined 141
certificates 133

self-signed 133
change-repository-password

command 101, 102
checklist

install grid software 12

prepare

software installation, for 10
virtual machines 11

CIDR

defined 141
CIFS

defined 141

integration testing 76
CLB

defined 141
CMN

defined 141
CMS

defined 141
command shell

accessing 134

login 134

log out 135
command, HTTP

defined 141
compression 62
Configuration.txt file 88
connect to NMS MI 132
container

defined 141
content block ID

defined 142

Continue Install GDU task 111
Control Node

defined 142

installation 51, 52

start software 55
copy-grid-spec command 95, 96
COPYSTGPOOL 20
corrupt ISO message 58
CSTR

defined 142

D

Data Center
defined 142
DC site
defined 142
deduplication 62
defined 142
default grid specification file 17,
89
deletion, testing 81
deployment grid specification
file 17, 89
disk storage pool
define a pool 63
distributed CMS. See metadata
replication
DNS configuration 62
Doc directory, in SAID package 88
domain policy
TSM 63
DR
defined 142
DR550
domain policy 67
storage pools 63
drivers 53

e-mail notifications
configuration 62
EMR
defined 142
Enable Services GDU task 54, 55,
57,111
Enablement Layer
CD 16
defined 142
StorageGRID Software CD,
for 34, 36
StorageGRID Software Service
Pack CD, for 35, 36
encryption keys 87
Error server state, in GDU 112
escrow keys 87
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exec bash, with GDU 109

F

FCS
defined 142
file shares 62
file system
backup, create 72
testing client integration 75
files
gdu-console.log 48, 58, 115
install.log 48, 58
Sample-MRLjpg 77
Sample_X-Ray.jpg 77
floppy image
provisioning 29, 39
Server Activation 38, 41
FSG
backups 72
attributes 73
defined 143
FSG replication group
defined 143
FTP client 17, 39, 95, 96

G

Gateway Node
defined 143
initial backup 72
installation 52
replication group
defined 143
testing client integration 75
GDU 109-116
Actions panel 112
console 109
defined 143
entering commands 113
1SOs 116
Log Messages panel 112
missing task 115
navigation 113
PuTTY, with 109, 115
quit, how to 114
screen, with 110, 116
Server Info panel 112
Servers panel 111
start command 110
Tasks panel 111
troubleshooting 115
GDU tasks
Continue Install 111
Enable Services 54, 55, 57, 111
Install Driver 111, 114
Install Software 52,111
Load Configuration 56, 111
Reboot Server 111, 114
Remount Storage 111
Start Services 112
Stop Services 112
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Update Software 112

Update Status 112

Upgrade Software 112
gdu-console command 110
gdu-console.log 48, 58, 115
glsetup.sh --enable-reformat 125
glsetup.sh script 121, 123, 124
glsetup.sh troubleshooting 124
GNU screen. See screen
GPT 87
GPT repository 38, 87, 100
grid

defined 149

networking 51

required ports 127

software

start 53
software install 51
grid node order 51

grid configuration 61-74
Grid Designer 17,18

OVF file 24

VM BOM 24
Grid ID

signed text block 143
grid node

defined 143

virtual machine 43
grid provisioning tool. See GPT
grid specification file 87-108

default 15,17, 89

defined 144

deployment 17, 89

edit 91

export 94,95

Grid Designer 18

naming convention 90

prepare for install 17

server names 91

structure 89

view 94

view in NMS MI 94

XML tags 92
grid tasks

defined 144

H

HAGC
definition 144
HCAC 54,132
definition 144
installation of primary 54
installation of secondary 57
heartbeat IP address
in grid specification file 94
High Capacity Admin Cluster. See
HCAC
HSM 20
HTTP
defined 144
HTTPS

defined 144

I

ILM
defined 144
policy 62
IMT 23, 30, 33, 43, 46, 104
Index.html file 41, 88
ingest, testing 77
inode
defined 144
Install Driver GDU task 111, 114
Install Software GDU task 52, 111
install.log 48, 58
installation
grid node order 51
grid software, of 51
manual 121
troubleshooting 124
next steps 74
overview 9
prepare 10
troubleshooting 58
verify client access 75
verifying client access 75
Interoperability Matrix Tool 23,
30, 33, 43, 46, 104
IP address
configuration 62
in grid specification file 92
ISO images
load 34
load_cds.py 36
ISO List action, in GDU 112
ISOs
copy to another site 117
missing, in GDU 116
required, missing, in GDU 116
service packs 117

K

KVM
defined 144

L
LAN
defined 145
latency
defined 145
LDR
defined 145
license
agreements 13, 38
Linux
load on virtual machine 30, 43
Load Configuration GDU task 56,
111
load configuration settings 55
load_cds.py script 34, 36, 123
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load-provisioning-software
script 38

log files
provisioning 106

log in
command shell 134
NMSMI 134

log out
command shell 135
NMSMI 134

M

main primary FSG
definition 145

Management Class, TSM
middleware 70

manual installation 121

Maximum Retrieve Sessions, TSM
middleware 69

Maximum Store Sessions, TSM
middleware 70

md5sum check 58

metadata
defined 145

metadata replication
definition 145

metadata synchronization
definition 145

missing ISOs, in GDU 116

namespace
defined 145

nearline
defined 145

network 51
required ports 127

NFS
defined 146

NFS integration
configure 47
testing 77

NMS
defined 146
entities in grid specification

file 92

NMS MI
alarms 56
browser connection 132
browser settings 131
configuration settings 55
connecting to interface 132
connection procedure 132
log in 134
log out 134
logging in 55
monitoring during

installation 55

password 55, 134
pop-ups, enabling 132
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security certificates 133
node ID

defined 146
Node Name, TSM middleware 70
NTP

defined 146

external sources, in grid

specification file 92

Number of Sessions, TSM

middleware 71
NXTSTGPOOL 20

o

object identifier. See OID 146
object segmentation
defined 146
object stores
defined 146
OID
defined 146
Open Virtualization Format
file 24
OVF file 18,24

P

password
NMSMI 134
ssh 135
TSM middleware 71
Passwords.txt 88, 134
Pingable server state, in GDU 112
pop-ups
enabling 132
ports
ingest 128
required 127
retrieve 128
postinstall
activate 121, 123
start 121, 124
postinstall.rb script 121, 123, 124
prepare for install
Grid Designer 18
grid specification file 17
required materials 15
TSM integration 18
virtual machine 23
prepare virtual machine 23
grid nodes, for 43
primary Admin Node, for 29
VMware ESX/ESXi 24
VMware vSphere 23
primary Admin Node 15
defined 146
server
driver install 53
start software 54
virtual machine 29
Linux install 30
load_cds.py 34

load_cds.py with ISO 36
provisioning floppy image 29
provisioning software
install 37
server activation 38
software distribution 34
VMware Tools 33
processing Admin Node
defined 146
processing NMS
defined 146
provision command 39, 97, 99
provision-crash-.log file 106
provision-fail.log file 106
provisioning 96-108
backup-to-usb-key
command 101
defined 147
errors 41
floppy image 39
create 29
GPT repository 87,100
grid 38
log files 106
passphrase 39
passphrase, change 100
procedure 96
software install 37
troubleshooting 41, 106
USB flash drive 98
without USB flash drive 103
provisioning-autoinst.xml file 15,
17,29
PuTTY, with GDU 109, 115

Q

Quit action, in GDU 112

R
Reachable server state, in
GDU 112
Reboot Server GDU task 111, 114
remote access 135
Remount Storage task, in
GDU 111
remove-revision command 107
reporting Admin Node
defined 147
reporting NMS
defined 147
required
materials 15
missing ISOS, in GDU 116
ports 127
retrieval, testing 79

S

SAID package
Configuration.txt file 88
defined 147
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Doc directory 87, 88
Escrow_Keys directory 87
grid specification file 88
Grid_Activation directory 87
Grid_Tasks directory 88
naming convention 87
Passwords.txt file 88
Samba
defined 147
Sample-MRLjpg file 77
Sample_X-Ray,jpg file 77
SATA
defined 147
screen 136
GDU, with 110
multidisplay mode 116
scripts
glsetup.sh 121, 123, 124
load_cds.py 34,123
load-provisioning-software 38
postinstall.rb 121, 123, 124
provision 39
updategrid.rb 121
vmware_setup.py 34, 47
SCSI
defined 147
secondary FSGs, testing
permissions 84
security certificates 133
security partitions
defined 147
segment container
defined 148
self-signed certificate 133
server
defined 148
names, in grid specification
file 91
password 135
remote access 135
Server Activation
media 41
USB flash drive 16
Server IP, TSM middleware 71
Server Manager
defined 148
Server Port, TSM middleware 71
service
defined 148
service laptop 25
requirements 17
service pack 16, 117
1SOs 117
SLES
defined 148
SNMP monitoring
configuration 62
SNTP 92
software
CD 16
distribution
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load_cds.py script 34
install 51
start 53
Software Activation and
Integration Data. See SAID
SQL
defined 148
ssh 135
defined 148
ssh key password 135
SSH Access Password, with
GDU 110
ssh access point configuration 62
ssh-add -D 114
ssh-add, with GDU 110
SSL
defined 148
SSM
defined 148
standby primary FSG
definition 148
start
virtual machine 28
Start Services task, in GDU 112
start software 53
Control Nodes 55
primary Admin Node 54
Start Task action, in GDU 112
Stop Services task, in GDU 112
storage compression 62
Storage Node
configure NFS storage
volume 47
defined 148
installation 52
StorageGRID Software CD 34, 36
StorageGRID Software Service
Pack CD 34, 36
Successful Backups attribute 73
supplementary primary FSG
definition 149
SUSE
defined 149
synchronized CMS. See metadata
synchronization

T

task signed text block
defined 149
TCP/IP
defined 149
Telnet/ssh client, with GDU 109,
115
testdata directory 77
throughput
defined 149
Tivoli Storage Manager. See TSM
TIVSM Installer CD 21
TIVsm-APLi386.rpm 16
TIVsm-BA.i386.rpm 16
TLS

defined 149
Total File Remove Notifications
attribute 79, 81, 82
Total Files Stored to Grid -
Successful attribute 78, 79
Total Managed Objects
attribute 78,79
transfer syntax
defined 149
troubleshooting 58
corrupt ISO messages 58
GDU 115
glsetup.sh script 124
manual install 124
postinstall.rb script 125
provisioning 106
virtual machines 48
TSM
alarms 56
Archive Node 69
configure 69
operation, and 19
best practices 18-21
client packages 16, 21
configure 69
Archive Nodes, for 18
defined 149
domain policy 63, 67
Hierarchical Storage
Management 20
integration 19, 62
required materials for
installation 11, 16
server 18
prepare 63
server (non-DR550) 67
storage pools 63
versions 21
TSM/SSAM 63

U

Update Software task, in GDU 112
Update Status task, in GDU 112
updategrid.rb script 121
Upgrade Software task, in
GDU 112
URI
defined 149
USB flash drives
Server Activation 16
Use font encoding setting in
PuTTY, with GDU 115
User Name, TSM middleware 71
UTC
defined 149
time 38
UTE-8 setting in PuTTY, with
GDU 109
UUID
defined 149
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v

virtual IP address
in grid specification file 93
virtual machine
automatic restart 26
create 25
manually 26
OVF file, with 25
definition 150
load Linux 30, 43
load_cds.py 34
OVF file 18,24
preparation checklist 11
prepare for install 23
primary Admin Node 29
Linux install 30
provision grid 38
provisioning floppy image 29
provisioning software install 37
service laptop 25
start 28
troubleshooting 48
VM BOM 24
VMware ESX/ESXi 24
VMware Tools 33, 46
VMware vCenter Server 24
VMware vSphere
client 25
install 23,24
Winlmage 17
virtual machines
grid nodes 43
VM BOM 24
VMware ESX/ESXi 24
VMware ESX/ESXi Server
installation 24
restart 26
VMware Tools
install 33, 46
virtual machine install 33, 46
vmware_setup.py script 34, 47
VMware vCenter Server 24
VMware vSphere
client 25
install 25
install 23,24
VMware vCenter Server 24
vmware_setup.py script 34, 47

w
WAN

defined 150
Winlmage 17
WinSCP 17, 39, 95, 96

X
XFS

defined 150
XML

defined 150
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